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1 Getting started

1.1 Introduction

Easy Data Transform allows you to quickly transform table and list data into new and more
useful forms, without programming. The step-by-step visual transformation is quicker, more
interactive, more repeatable and less error prone than other approaches.

Please take a couple of minutes to read the Quick Start Guide.

1.2 System requirements
The suggested requirements for running this software are:

e Operating system: macOS 10.12 or later.
e Screen resolution: 1280x720 pixels or better.

If your operating system is more recent than the above check our website to find a
compatible version of Easy Data Transform.

You may be able to run the software satisfactorily on lower specification systems or more
operating systems, but we can't guarantee it. If in doubt, try running an unlicensed trial
version before you buy a license.

1.3  Quick start guide

This is a quick tour of some of Easy Data Transform's features. It should only take a couple
of minutes to complete.

Start Easy Data Transform. If the Free Trial window appears, click Continue free trial. If the

Getting Started window appears, click I have used it before! (or you will just end up back
on this page). You should now see the main window.
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L L Easy Data Transform +1.4.0 {free trial)
DEEOQARQ#® o
v input

FremFiie (T

Froem Clipboard  (F)

Add data you want to transform by:
- dragging data files here; or
- clicking the 'From File' or 'From Clipboard® buttons

[ Email us questions/fesdback

Drag a data file you want to transform onto Easy Data Transform. Any sort of table or list
should be fine. For example a .csv file or an Excel .xIsx/.xls file. XML, JSON, fixed width and
vCard formats are also supported.
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N Easy Data Transform +1.4.0 {free trial)
DBEEOQ @ Q # & rhHwor
= Input testicsv @[5
Fremfie () . ' ' File: [UsersjandybyDeskiop/iest.csv
Froem Clipboard  (F) wateh file

z Transiarm Delimiter:  Aulomatic

€ 4

All ranstorms = Encoding:  Automatic
Case @ ’ lgnore; First O rowis) -
. + has header
i (7
Chap @ ¥ trim whitespace
Clane ® + simplify whitespace
o + ignare empty rows
Compare Cals L7} . . . Alias: test]
Concat Cols (}. Camment:
Copy Cols (&)
2 C||% & Show first 10 ows &
Count '®
@ . 7 testl.csv . title  firstrama  lastname  suffix  display name
= 23 esls » 64 rows 1 Mr Andrew  Adams Mr Andrew Adams
Date Format (7]
2 Mrs  Nikki Adams Mrs Nikki Adams
Dedups i)
3 Ms Rose Atwell Ms Rose Atwell
Extract &
i ':2-) 4 M Colin Ayar M Calin Ayar
Fiter O 5 Mrs  Michelle Slairg Mrs bichelie Blairg
Gathar {:I 8 M Siman [Blaire Mr Simon Blaire
F) ) 7 Mr  Albert Brown Mr Albert Brawn
ranrt & 8 Mz Cynthis  Brown Mrs Cynthia Brown
o) 9 Miss Jane Brawn Mrs Jane Brown
Javaseript (3) . 10 Mr David  Burgess Mr David Burgess
@

[ Email us questions/fesdback

Notice that the available transforms are shown in the Left pane and the selected dataset is
shown in the Right pane.

In the Right pane, you can check has header, depending on whether you want to treat the
first row of the dataset as a header.
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testl.csv @

KA
|

File: /Usersfandyb/Dropbox/testl.csv

Delimiter: Automatic

Encoding: Automatic

& &

lgnore:

simplify whitespace
ignore empty rows
watch file

Alias: test1

Comment;

22 cols x 64 rows

C [% V Show first 10 rows E

title first name last name suffix meal spe@

All the transforms available for a single dataset are now enabled in the Left pane. Hover
over the transforms to see tooltips explaining what they do. Click on the ? next to a
transform button for more details.

Ensure the input item is selected and click on the Case transform button to change the case
of your data.

Easy Data Transform © 2020 Oryx Digital Ltd
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‘soe Easy Data Transform vw1.4.0 (free trial)

DBEEO0QQAHE rumomr
v Input
From File (0]

Froem Clipboard  (F)

All ransforma

Casie
Chop &
Clane &

Compare Cols (7}

concatcols  (F)

Copy Cols @

Count @
® ' &

Date Format LA}

testl.csv

1} eods x 64 rows

Dedups i)
Extract I:Z)
Fill @
Eilter .:_r)
Gathar @

" .'?. .
ranr &
@

Javascript @ .
@

A Case transform item will now be added.

‘@ L ] Easy Data Transform ¥1.4.0 {free trial)

DBEEO0QAaa#FER rwnr
o Input
From File @

From Clinboard  (F)

hd Transform

All ransforma =
Case @
Shap &
Gione @

Compare Cols  (7)
Concai Cols {'—_h
CegyCols ()
Count @
® ' g

Date Format LA}

testl.csv

22 ool % B4 rEWE

Dadupe (?::
Extract l:z)
Fill &
Eilter .:_r:l
Gather (::".

1 (':5‘:
il @&
@

Jmvseript ()
@

Easy Data Transform

testicsy D52
File: MUsersiandybiDeskiop/fiest].cov
watch file
Dielimiter:  Automatic
Encoding: Automatic E
Igniare: First O rowis) =
has header
trim whitespace
simplify whitespace
ignare empty rows
Alias: test]
Carnmet:
C||% & Show first Wrows [
tithe  first rama | lastname  suffic | display name
1 L Andrew  Adams Mr Andrew Adams.
2 WS Mikki Adams Mrs Nikki Adarms
3 Ms Rose Atwell Ms Rose Atwell
4 Me  Colin Aol Mr Colin Ayer
5 Mrs  Michelle Slairg Mrs bichelie Blairg
8 M Siman [Blaire Mr Simon Blaire
7 Mr  Albert Brown Mr Albert Brown
@ Mz Cynthéa  Brown Mrs Cynthia Brown
8 Miss Jane Brown Mrs Jane Brown
10 M David Burgess Mr David Burgess
] Email us questionsffesdback
LT
wu
Q, Fifter calurm
title
first name:
last name
uffix
0 of 22 columns selected
Change case 10;  Lower Case E

Comment:
Change the case in the selected column(s).

G B & Show first 10 rows

tithe  first rame  lastname  suffic  display name

1 iy Andrew  Adams Mr Andrew Adams.
2 Mirs  Nikdki Adams Mrs Nikki Adams
3 Ms Rose Arwell Ms Rosa Atwell

4 M Colin Aper Mr Colin Ayer

5 Mrs Michelle Blaire Mrs Michalle Blaire
& Mr Simon  Blaire Mr Siman Blaire

7 M Albert Brawn Mr Albert Brawn

8 Mrs Cynthéa  Brown Mrs Cynthia Brown
8 Miss Jane [Brawn Mrs Jane Brown

0 M Dawig [Burgess Mr David Burgess

Last 54 raws nol shawn

] Email us questionsffeedback
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In the Right pane, check one of the columns and set Change case to to Upper case. All the
text in that column will now be converted to upper case.

Case @ E

E 'Q Filter columns

title
Irst name

last name

enffiv

1 of 22 columns selected

Comment;

Change the case in the selected column(s).

22 cols x 64 rows

4 Show first 10 rows E

first name last name suffix meal specia

Andrew Adams

2 | MRS |Mikki Adams

You can create a sequence of transforms to perform complex manipulations.

v Case Y Dedupe

39 caols x 50 rows

[ testl.csv

v v Sort

39 cok x 50 rows

39 mls x50 raws

39 cals x 50 raws

Some transforms require more than one input dataset. For example, to stack two tables, one
on top of the other:

¢ Select File>New to start again. Don't save the changes.

¢ Drag two data files onto the Center pane.

e Select both input items (by dragging a box around them or using cmd+click).

e Click the Stack transform button (you may need to scroll the Left pane to see the

button).

Easy Data Transform © 2020 Oryx Digital Ltd
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N Easy Data Transform «1.4.0 {free trial)
DEEOQAQRQE rrwor
rrarsect [
o ®
Looiug @
@
@
@ ) testl.csv

v

ZZ cols u 64 rows

v test2.csv

23 cols x 18 rown

Subsract &)

testicsw

File:

Delimiter:
Encoding:

Igre;

[UsersfandyhiDeskiop/test].cev

watch file
Autamatic

Automatic

First O rowis)

has header

trim whitespace
simplify whitespace
ignare empty rows

Alias: test]
Carnmet:
c|m/z

tite  first rama  lastname  su
1 L Andrew  Adams
2 WS Mikki Adams
3 Ms Fose Arwell
4 M Colin Myt
5 Mrs  Michelle Slairg
6 Mr Simon  Blaire
7 Mr  Albert Brown
@ Mz Cynthéa  Brown
8 Miss Jane Brawn
10 M Dawid Burgess

B Email us

Show first Wrows [

Mix  display nama
Mr Andrew Adams
Mrs Nikki Adarms
Ms Rosa Atwell
Mr Colin Ayer
Mrs bichelie Blairg
Mr Simon Blaire
Mr Albert Brown
Mrs Cynthia Brown
Mrs Jane Brown

Mr David Burgess

questionsfesdback

The tables are now stacked one on top of the other in a new dataset item. You can choose

to match the columns by Header name or Column number.

- [ ] Easy Data Transform «1.4.0 (free trial)
DBEO0QA® # @ rhHwoor

dwemszriot ()

@

@

Mew Cod @
Nurmn Format @
Pad @&
Biver [@)]
Remove Cols  (7) testl.csv
Rename Col l:;:' ) <

22 ol x 64 rows

Recrder Cols (7
Raplace @

Aow Mum (zf\.l

Stack

Sample @ 22 esis % B rows
Sart @

sacs @ test2.csv

Sareat [ o A

Stamp @

Stats @.

Subititute @&

@
summary ()
Total @

Transpose [0

Easy Data Transform

Stack

LT
wu

Align columns byd, Header name ) E

Comment:

Stack rows of all inputs. Orders by the vertical (Y] position

af the input dataseds.

G& A 5

Tithe
1 M
2 i
3 Ms
4 i
5 Mrs
L
T M
LI
9 Miss
WM

first rame | lastname  sul

Andrew  Adams

Nikdkci Adams
Rosa Avwell
Colin Ayer
Michelle Elaire
Simon  Blaire

Albart Brown
Cynthia  Brawn
dane Brown

David  Burgess

Last 72 rows not shawn

£ email us

mow fira1 10 rews [

Mix | display name

Mr Andrew Adarms
Mrs Milkki Adams
Ms Rose Atwell
Mdr Colin Ayer

Mrs Michelle Blaire
Mr Siman Blaire
Mr Albert Brown
Mrs Cynthia Brown
Mrs Jane Brown

Mr Dvid Burgess

gquestionsifeedback
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Note that the vertical (Y) position of the inputs affects the order the datasets are stacked.
Try swapping the two inputs around and re-select Stack to see the affect.

Any changes to input files will be automatically read in. Any changes to input datasets or
transform options will be automatically propagated 'downstream’.

To export your transformed dataset to a file or the clipboard, or to view it in a local editor,
select the dataset item and click on the appropriate button in the Right pane.

Stack el

Align columns by: Header name H

Comment:
Stack rows of all inputs. Orders by the vertical () pusitinn'
of the input datasets.

([% B 7)) Show first 10 rows E,

You can also add an output item to automatically write a dataset to file whenever it

changes.
- [ ] Easy Data Transform «1.4.0 (free trial)
DBE0QA R H#E® rhHwoor
Hew Col @ Stack @[22
Hum Format "\3} : | ) ) Align columns by:  Header name H
Pad ':2-) Commaent:
Pivot 0] Stack rows of all inpuis. Orders by the vertical [Y) position
= of the input datasets.
Remove Cols {:::
Shiw Tirs1 10 rews
Rename Col 5 G [El .f " ﬂ
Peceder Cols .,‘2) tithe  first rame  lLastname  suffic  display name
S & . 1 Mr Andrew  Adams Mr Andrew Adarns:
testl.csv ke k]

M (—'} v 2 Mg Nikki Adams Mrs Milkki Adams
Samule @ e 3 Ms  Rose  Atwel s Rose Atwel
Saet ()] 4 Mr  Colin Ayer Mdr Colin Ayer
St Cad & Stack 5 Mrs  Michelle Blaire Mrs Michalle Blaire

"'k“ .
Soread [0 Y R & Mr  Simon [Bilaire Mr Siman Blaire
':' T M Albert Brown Mr Albert Brawn
Stamp @ 8 Mrs Cynthia  Brown Mrs Cynthia Brown
P ” test2.csv
Stats (7 8 Miss Jane Brown Mrs Jane Brown
— & 22 coli x 18 rows
= W M David Burgess Mr David Burgess
Summar )
Y W Last 72 rows not shawn
Total @
Transpo sd L?:'

Teim

] Email us questions/feedback
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You will be asked for a file to write to. You can choose amongst CSV, Excel, HTML, JSON,
Markdown, TSV, vCard, XML and YAML file formats. Select CSV file.

Save As: output V
Tags:
Where: " andyb a

v CSV file (*csv)

Excel fileb{*.xlsx)

- [l [N Y [SE—

Your dataset will then be written to this file every time it changes.

- [ ] Easy Data Transform «1.4.0 (free trial)
DEEBAQARQHE® rwnn
. '::’:' output.csv @ :;1:
@ File: [Users/andyb/output.csv
@ Dalimiter: Comma () %]
@ Encading: UTF-B ™
@ . i . Values as:  Mod
(?} Byte Order Mark
@ Write mode:  Overwrite B8
@ Alias: output
® v testl.csv Comment:
(::". Lk (i & &2 Show first 10 rows B
@. tithi | TirE Al W) A SUMiE | dipli Rame
& Stack output.csv 1 Mr Andrew  Adams Mr Andrew Adams
| —d
'@ 23 cols x &Y rows 23 cols x B rows 2 Mz Mikki Adams Mrs Mikki Adams
@ 3 Ms  Rose  Atwell Ms Rose Atwed
(E’:' 4 Mr Colin Ayar Mr Colin A
yar
C8V
g v test2.cs ] ] . )
— & M Michelle Blaire Mrs Michelle Blaire
(.2) &3 coln x 18 rows
& Mr  Simon [Blaire Mr Siman Blaire
@
ToME o Albert Brown Mr Albert Brawn
o
@ 8 Mrs Cynthia Brown Mrs Cynthia Brown
7
"i) 9 Miss Jane Brown Mra Jane Brown
7
® Wl David Burgess Mr David Burgess
o Dutput
@ Last 72 rows not shown

= Email us questionsifeedback

You can also specify the Delimiter and Encoding for your CSV files in the Right pane.
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output.csv E Z

File: /Users/fandybfoutput.csv

Delimiter:

Encoding:

Byte Order Mark

Write mode: Owerwrite

Alias: output

Comment:

You can save your transforms to a transform template document to use again with
File>Save.

Have a play!

Tips:

e You can also paste in data from the clipboard (for example, a table from a web page or
Word document).

e The Compare cols, Filter, If and Sort transforms take account of dates, numbers and text.
You can define what date formats to recognize in the Preferences window.

¢ New columns are always added to the right of a table.

e Comparisons of text are always sensitive to case, unless stated otherwise. E.g. "CASE",
"case" and "Case" are treated differently.

e Comparisons of text are always sensitive to whitespace (e.g. spaces and tabs), unless
stated otherwise. You can use the Whitespace transform to remove leading and trailing
whitespace.

e The contents of input and output data files are not saved in Easy Data Transform, only
their locations.

e As well as stacking two datasets, you can also Join them, side-by-side, if they have a
common (‘key") column.

¢ You can insert a new transform between existing items by selecting the connection
between the items and then adding the transform.

¢ You can perform the same set of transformation on multiple files using Batch processing
or command line arguments.

e Use keyboard shortcuts to improve your productivity.

We are interested in your feedback, so please contact us to ask a question, report a bug or
request an enhancement.

Easy Data Transform © 2020 Oryx Digital Ltd
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2 Reference

2.1 User Interface
2.1.1 Main window

The Main window comprises:
¢ Main menu
e Tool bar

o Left pane
o Center pane

¢ Right pane
e Status bar

Tool bar Left pane Center pane Right pane

- [ ] Easy [ta Transform «1.4.0 {free trial)

DEEOoQAQFEE rremon

- input output.csv 3|53
] -
FromFile () File: [Users/ancybjoutput, csy -
From Clioboard  (7) Delimiter:  Comma () %]
¥ Transform Encoding:  UTF-B =]
Al transtorms A Vil .
alugs as:  Nod
W2 Byte Order Mark
'f?:' Wirite mode:  Overwrite H
)] o bestl. cov Alias: output
.\’2’) B Commaent;
@ ~
\:\ o Stack " . Dedupe o, DUtpUL.CSY [N WP Show first 10 rews [
L / —— i — —— ile | first name |lastname  suMix | display name
@ ! i Mr Andrew  Adams Mr Andrew Adams
-  testZcsv
~ 2 Mrs  Mikki Adams Mrs Mikki Adams
(7
2 3 Mz Rose  Atwall M3 Rose Atwell
@
— 4 Mr  Colin Ayer Bdr Calin Ayer
&
= 5 Mrs Michelle Elaire Mrs Michelle Blaire
@
= 6 M Simon  Blaire Mr Sirmon Blaire
]
=y 7 M Albert Brown Mr Albert Brown
(2
@ 8 Mrs Cynthia  Brown Mrs Cynthia Brown
T ) Email us questions/fesdback
Status bar Input Transform Output

2.1.2 Left pane

The Left pane shows all the available actions you can perform. Which actions are visible will
depend on what is shown in the Center pane. Which actions are enabled depends on what
is selected in the Center pane.

2.1.3  Center pane

The Center pane show the inputs, transforms and outputs you are using to transform your
data.
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2.14  Right pane

The Right pane shows details of any input, transform or output items you have selected in
the Center pane.

2.1.5 Preferences window

General tab
Check open previous file at start-up if you want to start with the last file opened.

Check give option to disable outputs when opening a file if you want the option to
disable any ouputs with write mode overwrite or append when you open a file, preventing
accidentally writing over existing files. Note that this check is never made when using the -
exit command line argument.

Check use native file windows to use the native Mac file open/save windows. There is a
known issue with macOS 10.15 that may cause crashes using native windows.

Check make a sound when processing completed if you want to make a system sound
every time processing is completed.

Set Tool bar icon size to the size of the icons you wish to display in the tool bar.

Set Right pane processing delay depending on how long you want to wait after changes in
the Right pane before starting processing. Setting the value to 0 is generally not
recommended, as this means that every single click in the Right pane will cause processing.

Set Zoom wheel behavior according to how you want the mouse wheel to work in the
Center pane. Hold down the option key while moving the mouse wheel to switch between
zoom and scroll. If Scroll direction: Natural is checked in your Mac Settings>Mouse then
the directions will be reversed.

User interface font shows the font used for the application user interface, apart from data
tables (see below). Click Choose... to choose a new font. Click Default to set it back to the
operating system default.

Data table font shows the font used in the data tables in the Right pane. Click Choose... to

choose a new font. You might prefer a monospaced (fixed width) font such as Monaco or
Courier New. Click Default to set it back to the operating system default.

Easy Data Transform © 2020 Oryx Digital Ltd



Reference

The Locale language and country setting affects how some numbers and dates are
displayed. Consequently it may an affect on some transforms. It does not change the
language of the user interface, which is English only.

Set Supported date formats to the date formats you wish to recognize. List the date
formats in order of preference, with the most likely to be used first.

Input Extensions tab
Set the default file types corresponding to input file extensions.

Click in the Extension column and type to change an input file extension. The text will be
trimmed of whitespace, converted to lower case and any ".' characters removed.

Click in the Default type column and change the drop-down list to change the file type to
associate with an input file extension.

Click Add to add a new input file extension.
Click Remove to remove the selected input file extension(s).
Click Default to set the input file extensions back to the default setting.

The order in which input file extensions are shown is not significant.

Output Extensions tab
Set the default file types corresponding to output file extensions.

Click in the Extension column and type to change an output extension. The text will be
trimmed of whitespace, converted to lower case and any "' characters removed.

Click in the Default type column and change the drop-down list to change the file type to
associate with an output file extension.

Click Add to add a new output file extension.
Click Remove to remove the selected output file extension(s).

Click Default to set the output file extensions back to the default setting.
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The order in which output file extensions are shown is not significant.

2.2 Input
221 Input data

You need to input data before you can transform it. Data can be input by:
e dragging a file onto the Center pane; or
e clicking the From File or From Clipboard button in the Left pane

Enter the file location in File or click the browse button. For Excel spreadsheets you also
need to add a sheet name, e.g. 'MySpreadsheet.xIsx[Sheet1]".

Easy Data Transform can input data from files in the following formats:
e delimited text file (e.g. CSV or TSV) with various delimiters

e Excel .xlIsx or xls

e fixed width

e JSON

e vCard

o XML

You can select the input item in the Center pane and change any related options in the
Right pane.

testl.csv @ tF E:

File: fUsersfandyb/Desktop/testl.csv

Type: Delimited text

Encoding: Automatic

<
Delimiter: Automatic H
T

Ignore: First O row(s)
has header
trim whitespace
simplify whitespace
ignore empty rows

watch file
Metainfo: Mot added H
Alias: testl

Comment:
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Set Type to the file type. The default type will be set according to the file extension and the
settings in the Input Extensions tab of the Preferences window.

Easy Data Transform will make an intelligent guess at the:

column delimiter (e.g. comma) for delimited text files

column widths for fixed width text files

text encoding (e.g. UTF-8) for text files

e presence of a header row in the data

But you can also do this manually by selecting the input item and changing the Delimiter,
Columns, Encoding and has header fields in the Right pane.

Data will normally be read from the first non-blank line. Set Ignore if you want to ignore a
number of rows before you start inputting. Note that empty rows are counted.

Set Format to Long (more rows) or Wide (more columns) depending on how you want
to treat arrays/repeat values in JSON or XML.

Check trim whitespace to trim any whitespace (e.g. tabs or spaces) off the start or end of
data values.

Check simplify whitespace to replace any tabs or line feeds within data values with spaces
and remove carriage returns.

Check Ignore empty rows to remove any rows that have only empty values (whitespace is
not considered empty).

Check watch file if you want the file to be automatically reloaded every time that Easy Data
Transform detects that it has been changed (which will then update everything
‘downstream’).

Use Meta info if you wish to add some meta information about the input dataset, e.g. the
name of an input file or the date it was created.

Use Alias to identify the file for batch processing.

Use Comment to record any notes that might be useful to a colleague or your future self.

To change the file being used by an input, select the input item and change the file location
in the Right pane (e,g, by clicking the "..." browse file button), rather the disconnecting the
input and connecting a new one. Otherwise column-related parameters downstream will be
reset.
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2.3 Transforms
2.3.1 Transform data

Transforms operate on datasets from input data or other transforms. Some transforms only
have a single input (e.g. Case), some transforms have two inputs (e.g. Join) and some
transforms have two or more inputs (e.g. Stack).

To create a transform, select one or more input and/or transform items in the Center pane
and then click the appropriate button in the Left pane.

Select from the drop-down list in the Left pane to choose which types of transform are
displayed, e.g. select Merge Transforms to show only transforms related to blending data.

You can select the transform item in the Center pane and change any options related to the
transform (e.g. which columns it acts on) in the Right pane.

The transform will be updated automatically if any input or transform ‘upstream’ of it
changes.

Use Comment to record any notes that might be useful to a colleague or your future self.

2.3.2 Case

Description
Changes the case of text in one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Change case to to Lower case (e.g. "text"), Upper case (e.g. "TEXT") or Title case (e.g.
"Text").

See also
e Whitespace
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233  Chop

Description
Remove characters from the start or end in one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Length to the number of characters you want to remove.

¢ Set From to Start or End depending on whether you want to remove characters from the
start or end.

Notes

e Whitespace is counted when calculating length. You can use Whitespace to remove
whitespace before chopping.

e If you want to set a column to a fixed length use Pad and Chop together.

See also
e Extract

234 Clone
Description

Makes an exact copy of the input dataset.

Inputs
One.

Options

e None.

Notes
e Clone can be useful to simplify complicated layouts.

2.3.5 Compare Cols

Description
Creates a new column with a comparison of two other columns.
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Inputs
One.

Options

e Select the two columns you wish to compare as Column 1 and Column 2.

Notes

e Number, date and text values are treated differently. Any values that can be converted to
a number will be treated as a number. Any values that match the supported date formats
in Preferences will be treated as a date. All other values are treated as text.

e Comparisons of text are case and whitespace sensitive. You can use Case to change the
case, Whitespace to remove whitespace before filtering and Replace to get of other
unwanted characters (e.g. whitespace inside the text).

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

See also

e Split Cols
2.3.6 Concat Cols

Description
Creates a new column by concatenating text from one or more existing columns.

Inputs
One.

Options
e Check the columns you wish to concatenate.
e Supply the Delimiter you wish to place between concatenated text (optional). For

example ",".
e Check keep empty if you wish to keep the delimiter for empty columns.

Notes

e If there is a header, the header of the new column is formed from the header of the
concatenated columns. You can use Rename Cols to change the new column name.

e Concatenating a single column makes a copy of the column.

e The values in the column are in the order of the columns. You can change the column
order before concatenation with Reorder Cols.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.
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e The opposite of Concat Cols is Split Col.

See also
e Concat Rows
e Substitute

2.3.7 Concat Rows
Description

Concatenate multiple consecutive rows into a single row.

Example
Concatenating this dataset:

sensor datetime value
1 sensorl 1/1/18 0:00 578

3 sensor1 1/1/18 0:10 541

4 sensor2 1/1/18 0:10 702

Every 2 rows:

Concat Rows @ (P E :

{3

Create 1 row from every: 2

Gives:
sensor datetime value sensor datetime value
1 sensor1 1/1/18 0:00 578 sensor2 1/1/18 0:00 764
2 sensorl 1/1/18 0:10 541 sensor2 1/1/18 0:10 702
Inputs
One.
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Options

e Set Create 1 row from every to N to concatenate every N rows into 1 row.

Notes

e Use New Col if you need to add additional columns before concatenating rows.
Use Filter if you need to remove rows before concatenating row.

Use Rename Cols if you need to change column names after concatenating rows.
The opposite of Concat Rows is Split Rows.

See also

e Spread
e Concat Cols

2.3.8 Copy Cols

Description
Creates one or more copies of the selected column(s).

Inputs
One.

Options
e Check the columns you wish to copy.
¢ Set Copies to the number of copies you want to make of each checked column.

Notes

e If there is a header, the header of each new column is the original column name. You can
rename columns with Rename Cols.

e The new columns are added at the right end. You can change the column order with
Reorder Cols.

See also
e New Col

239 Count

Description
Counts the number of occurence of each item of text in the selected column.

Inputs
One.
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Options

e Select the Column whose values you wish to count.

¢ Set Sort by depending on whether you wish to sort alphabetically by the Text in the left
column or numerically by the Count in the right column.

¢ Set Order depending on whether you wish to sort Ascending or Descending.

Notes
e Date and number values are treated as text.
¢ You can use Rename Cols to change the new column name.

See also
e Pivot
e Stats

e Summary
2.3.10 Cross

Description

Creates an output from combining every possible row combination of each input. E.g. if the
first input has N1 rows and the second input has N2 rows, then the result will have N1 X N2
rows. Also known as a 'Cartesian product' or 'cross join'.

Example
letter
I L . letter number
' Clipboard 1A 1
\ 1 col x 3 rows 2A 2
3C
3A 3
Cross 48 |
R/ 8
2 cols x 9@ rows 5B 2
number 6B 2
11 y el
' Clipboard
20— 8C 2
I-\_\ 1 col x 3 rows
33 9cC 3
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Inputs

Two or more.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

Notes
e |t can create a very large number of rows!

2.3.11 Date Format

Description
Changes the date format in one or more columns.

Example
To change from "31/1/2019" to "01-31-19" set Format from to "d/M/yyyy" and Format to
to "MM-dd-yy".

Inputs
One.

Options

e Check the columns you wish to transform.

e Supply the existing date format in Format from (see below).

e Supply the new date format in Format to (see below).

¢ The following date formats are supported for input and output:
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Format Meaning

d The day as number without a leading

zero (1to 31)

e The day as number with a leading zero
(01 to 31)

ddd The abbreviated localized day name (e.g.
‘Mon' to 'Sun'). Uses the locale to localize
the name.

grelelel The long localized day name (e.g.

‘Monday' to 'Sunday'). Uses the locale to
localize the name.

M The month as number without a leading
zero (1to 12).

MH The month as number with a leading zero
(01to 12)

MMM The abbreviated localized month name

(e.g. Jan' to 'Dec'). Uses the locale to
localize the name.

elLely! The long localized month name (e.g.
‘January' to 'December’). Uses the locale
to localize the name.

Yy The year as a two digit number (00 to 99).

yyyy The year as a four digit number. If the
year is negative, a minus sign is
prepended in addition.

Notes

e The Locale set in the Preferences window is used to decide how the date is represented
(e.g. names of months and days).

¢ You can also use Split Col to split a date into its component parts. For example to split
"31/1/2019" into day, month and year components using the "/" delimiter.

e If the date to be converted has only two year digits, it is treated as a date between 1900
and 1999. E.g. "31/1/19" is interpreted in d-M-yy format as 31st January 1919.
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See also
e Num Format

2.3.12 Dedupe

This transform is deprecated. Use Unigue instead.

Description
Remove duplicate rows.

Example
If you are cleaning up a mailing list, you might want to dedupe on the 'email’ column, after
converting all the emails to lower case.

Inputs
One.

Options

e Check the column(s) you wish to look for duplicate values in.

Notes

e Rows are considered duplicates if they have exactly the same value in all the columns
selected.

e Comparisons are case and whitespace sensitive. You can use Case to change the case and
Whitespace to remove whitespace before deduping.

e When several rows are duplicates, only the top one is retained.

See also
e Dedupe a dataset

2.3.13 Extract

Description
Extract a length of text in one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.
¢ Set Length to the length you want values in selected columns shortened to.
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¢ Set From to Start or End depending on whether you want to take from the start or end.

¢ If From is Start then Offset is the offset of the first character from the start (0 to start
with the first character). If From is End then Offset is the offset of the last character from
the end (0 to start with the last character).

Notes

e Whitespace is counted when calculating length. You can use Whitespace to remove
whitespace before extracting.

e If you want to set a column to a fixed length use Pad and Extract together.

See also

e Chop
2.3.14 Fill

Description
Fill empty cells in selected columns with the next non-empty cell value above/left
(depending on direction of fill).

Example
This is useful for filling in gaps in hierarchical tables. For example filling down the first two
columns:
Country 1 Area 1 City 1 Country 1 Area 1l City 1
City 2 Country 1 Area 1 City 2
City 3 * Country 1 Area 1 City 3
Area 2 City 1 Country 1 Area 2 City 1
City 2 Country 1 Area 2 City 2
Inputs
One.
Options

e Check the column(s) you wish to fill.
¢ Select Direction depending on the direction you wish to fill from.
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2.3.15 Filter

Description
Removes rows based on number, date and text values in selected columns.

Inputs
One.

Options

e Click the '+' button to add a new filter criteria.

e Click the 'x' button to delete the selected filter criteria.

¢ Select Keep if you want to keep matching rows and Remove to remove matching rows.

¢ Select Matching all to match on all criteria (e.g. criteria 1 and criteria 2). Select Matching
any to require a match on one or more criteria (e.g. criteria 1 or criteria 2).

e Set Column to the column you wish to match.

e Set Op. to the comparison operator.

¢ Set Value to the value you wish to compare.

Notes

e A filter row is ignored if the Value column is empty , except when Op. is Equal to, Not
equal to, Matches regex or Doesn't match regex.

e Number, date and text values are treated differently for Equal to, Greater than, Less
than, Greater than equal, Less than equal and Not equal to operations. Any values that
can be converted to a number will be treated as a number. Any values that match the
supported date formats in Preferences will be treated as a date.

e All values are treated as text for Contains, Starts with, Ends with, Matches regex, Is not,
Doesn't start with, Doesn't end with and Doesn't match regex operations.

e Comparisons of text are case and whitespace sensitive. You can use Case to change the
case, Whitespace to remove whitespace before filtering and Replace to get of other
unwanted characters (e.g. whitespace inside the text).

e See here for more details on Regular expressions (regex).

2.3.16 Gather

Description
Gather multiple columns into new key and value columns. Also called unpivot, long pivot or
group by.
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Example

salesman area QIUIGZINIGaNNGE
1Alice  North 113 893 443 18

2 Bob East 45 79 8 2z

With columns Q1, Q2, Q3 and Q4 gathered:

Gather e

¢y
E |Q Filter columns '

salesman

arga
Q1
Q2
Q3
Q4

4 of 6 columns selected

(<J Q< J<

Key column name: Quarter

Value column name: Amount

Comment:

Gives:
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salesman area Quarter Amount

1 Alice North Q1 1.3
2 Alice ;
3 Alice E
4 Alice ;
5 Bob 45
6 Bob 79
7 Bob 8
8 Bob 33

Inputs

One.

Options

e Select the Columns you wish to gather.

¢ Set Key column name to the name of the new key column, which will have values based
on the names of the columns selected.

e Set Value column name to the name of the new value column, which will have values
based on the values in the columns selected.

Notes

e New columns are added at the right end. You can change the column order with Reorder
Cols.

e You can merge the value and key columns into a single column with Concat Cols.

e The opposite of Gather is Spread.

See also

e Split Rows
2.3.17 Header

Description
Move rows from the top of the dataset into the header.
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Example

Sample Sample Sample
11 2 3
222333 93883 923482
39082.43 946.88 620.09

49397 148.64 45520

With 1 row appended to the header:

Header ©) =2
Top rows to move: 1 " !
Existing header: Append H :
Delimiter: - !

Gives:
Sample-1 Sample-2 Sample-3

122333 93883 923482
2908243 94688 620.09
393.97 14864  455.20

Inputs

One.

Options

e Set Top rows to move to the number of rows you want to move from the top dataset
into the header. Setting it to 0 means the transform does nothing.
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¢ Set Existing header to Overwrite to ignore the existing header values and Append to
add to the existing header values.

o Set Delimiter to any text you want to put between column elements. It can be left empty.
Ignored if Existing header set to Overwrite and Top rows to move set to 1.

Notes

e Empty cells are ignored.

e You can Sort and Filter your dataset to change the top rows.

e You can add the header from one dataset to another dataset using Stack.

See also
e Headers
2.3.18 |f

Description
Sets the value of a new column based conditionally on values in one or more other columns.

Inputs
One.

Options

e Click the "+IF' button to add a new IF/ELSE IF..THEN condition.

e Click the '+AND' button to add an AND to the selected IF/ELSE IF.. THEN.
e Click the 'x' button to delete the selected IF/ELSE IF.. THEN/AND.

e The Logic column shows the type of row.

e Set Column to the column you wish to match.

e Set Op. to the comparison operator.

¢ Set Value to the value you wish to compare.

Notes
e The THEN and ELSE values can use column variables. For example:

IF x =0
THEN $ (1)
ELSE
$(2)

e You can simulate OR with multiple IF statements. For example:

IF x=10R vy =2
THEN 3

Is equivalent to:
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IF x =1
THEN 3
ELSE IF y = 2
THEN 3

¢ Number, date and text values are treated differently for Equal to, Greater than, Less
than, Greater than equal, Less than equal and Not equal to operations. Any values that
can be converted to a number will be treated as a number. Any values that match the
supported date formats in Preferences will be treated as a date.

¢ All values are treated as text for Contains, Starts with, Ends with, Matches regex, Is not,
Doesn't start with, Doesn't end with and Doesn't match regex operations.

e Comparisons of text are case and whitespace sensitive. You can use Case to change the
case, Whitespace to remove whitespace before filtering and Replace to get of other
unwanted characters (e.g. whitespace inside the text).

e See here for more details on Regular expressions (regex).

See also

e Lookup
2.3.19 Insert

Description
Append/prepend text to one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ In Insert put the text you want to insert. You can use a column variable.
¢ In At put the position you want the text inserted.

Notes
e You can use Whitespace to remove whitespace before inserting.

See also

e Pad
e Extract
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2.3.20 Interpolate

Description
Interpolate values for a dataset based on numerical sample-value pairs in another dataset
and puts the result in a new column.

Example

If you have time and temperature datasets for sensors A and B with different sampling
frequencies, you merge the two datasets by interpolating the temperature values of B for
for the times A was measured.

First dataset:

time A temperature A
100 1.134
iz 1.0 3.778
320 2.773
4 3.0 5.039
54.0 3.333
6 5.0 2.874

Second dataset:

time B temperature B
100 0.000
220 1334
340 2.697
46.0 3931

Interpolation transform:
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sensor-A.csv
v

2 cols x 6 rows

-JInterpolate

3 cols x 6 rows

sensor-B.csv
v

2 cols x 4 rows

Interpolate Q-2 [ie

Top Sample column:  time A

Bottom value column: temperature B

Bottom Sample column:  time B H
]
T

Interpolation type: Linear

Result:
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| time A temperature A Interpolate temperature B

100 1.134 0
I2 1.0 3.778 0.667
320 2.773 1334
430 5039 2.015
54.0 3.333 2.697
650 2.874 3.314

Inputs

Two.

Options

e Place the dataset you want to modify as the top input and the dataset you want to
sample values from as the bottom input.

¢ Select Top sample column for the column whose values you wish to sample.

¢ Select Bottom sample column for the column that matches the top sample column in
the bottom dataset.

¢ Select Bottom value column for the column that contains the values.

¢ Set Interpolation type to the type of interpolation you wish to use.
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Piecewise interpolation (image from Wikipedia)
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Linear interpolation (image from Wikipedia)

Notes

e If your sample is below the first sample in the bottom dataset, the first value will be
returned.

e If your sample is above the last sample in the bottom dataset, the last value will be
returned.

e Easy Data Transform will try to guess sensible default values for Top sample column,
Bottom sample column and Bottom value column based on column contents.

o If the first input has a header, this will be used for the output.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

e Use Num Format to change the precision of the results.

See also

e Lookup
e Join
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2.3.21 |Intersect

Description
Keep only rows from the top dataset with key values that are present in the lower dataset.

Inputs

Two.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

e Select Top key column for the column you want to match in the top input dataset.

¢ Select Bottom key column for the column you want to match in the bottom input
dataset.

Notes

e If there are 10k rows or less in both datasets, Easy Data Transform will try to guess
sensible default values for Top key column and Bottom key column based on column
header names and contents.

o If the first input has a header, this will be used for the output.

e All values are treated as text and comparisons are case and whitespace sensitive. You can
use Case to change the case and Whitespace to remove whitespace before the intersect.

¢ Does not remove duplicates. You can use Unique to do this.

e You can use Concat Cols to join several columns together (e.g. 'first name' and 'last name’
columns) to form a key column.

e You can use Row Num to create a unique key column.

See also
e Subtract

2.3.22 Javascript

Description
Create a custom transform using Javascript (ECMAScript).

Easy Data Transform allows you to carry out a wide range of data transformations without
programming. But sometimes you might need a specialist transformation that can't be done
with the built-in transforms. For that you can use the Javascript transform. It allows you to
write the body of a Javascript function, to calculate a value for each row in a new column.
Existing column values can be used as variables.

Javascript is a fully-fledged programming language and can perform arbitrarily complex
transforms. It can handle numbers, dates and text.
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Examples
To multiply the value in column 'items' by the value in column ‘item price":

return $(items) * $(item price);

To concatenate 'last' and 'first' columns with a comma and a space:

return $(last) + ', ' + S$(first);

To calculate the biggest of columns 'v1' and 'v2"
return Math.max( $(vl), $(v2) );

To determine whether phone numbers in the '‘phone_num' column are valid using a regular
expression:

const validPhoneNum = /~[\+]2[(12[0-91{3}[)]12[-\s\.12[0-91{3}[-\s\.1?[0-9](4,6}$/;
if ( validPhoneNum.test ( $(phone num) ) )

return "valid";
else

return "invalid";

To replace the last comma in the 'Location’ column with a '} using a regular expression:

return $(Location) .replace(/(.*), ([~ 1*)S$/, '$1;$2");

To calculate the number of years difference between Javascript compatible dates in column
1 and column 2:

return new Date( $(1) ).getFullYear() - new Date( $(2) ).getFullYear():;

To calculate the number of milliseconds between a date in the 'date' column and 1st Jan
2000:

return new Date( $(date) ) - new Date( "2000-01-01" );

To calculate the number of whole days difference between a date in the 'created' column
and today (negative for future dates):

return Math.floor( ( new Date() - new Date( $(created) ) ) / ( 1000*60*60*24 ) );
To use the value of the 'n' column if it is a number and O if it isn't:

if ( isNaN( $(n) ) )
return 0;
else
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return $(n);

To reverse the text in the 'key' column:

var newString = $(key);

for (var 1 = a.length - 1; i >= 0; i--) {
newString += al[i];

}

return newString;

Inputs
One.

Options

e Enter your script into the Javascript field. The script should be the body of a Javascript
function.

e Select a column from Insert variable to add that column variable into the Javascript field
at the current cursor position.

e Click the Evaluate button to evaluate your Javascript expression over every row and show
any errors.

Notes
e The Javascript transform is calculated every time:
o The Evaluate button is pressed.
o The Javascript transform item is unselected in the Center pane and script changes have
been made without the Evaluate button being clicked.
o The item upstream of it changes.

e Numeric values should use dot ('.") as the decimal separator and have no group separator.
E.g. 1234.5 is valid, but 1,234.5 and 1.234,5 are not, regardless of the locale set in the
Preferences window. You can use the Num Format and Replace transforms to put
numeric data in the correct format before processing the Javascript transform.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

¢ Any errors from the Javascript engine are shown in a message window when Evaluate is
clicked.

e The Javascript Date() object evaluates to the number of milliseconds since 1 January 1970
UTC. Date() is the current date.

e Date values passed to Javascript Date() objects should be in ISO ('yyyy-mm-dd’) format,
e.g. '2020-01-31' (not '2020-1-31").

e If you want to carry out your transform across more than one dataset, you should Join
them first.

e The Javascript transform is very versatile and quite fast. But is not as fast as built-in
transforms. So we recommend you use built-in transforms where possible.
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e Javascript running in Easy Data Transform is not 'sandboxed' and has the same privileges
as the Easy Data Transform executable. However the Javascript does not have access to
window(), XMLHttpRequest() or ActiveXObject(). So we aren't aware of any way that a bad
actor could damage your system from Javascript sent in a .transform file.

e Javascript is far too big a topic to cover here. However there are many detailed resources
online. If you are stuck contact support.

e If you only want to combine text from columns, use the simpler Substitute transform.

See also
e Find the difference between dates/datetimes

2.3.23 Join

Description

Join two inputs based on common (key) columns, e.g. on an email address or id column
present in both inputs.

Example
Joining these two datasets by the ID column in each:

Name ID DOB ID Department Level
lﬁn Black 001 1966-0?313 601 Engineering 1)

=

o]
P

Paul White [002 1973-03-11 003 Engineering 2

3| Barry Green 0031 1977-12-30 I 3|004 Marketing 1

Lo

Jane Brown 004 1980-11-03 41002 Sales 2

'@5 Sales 3 /

i

IEKJllTaupe D05 1981-[!3—_{})

Gives:
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Name 1D DOB Department Level
1 ﬂ,c:;n Black IGlﬂl\\'LE!E-EI-'CII"h"',Filr'mg;in.t—:'erinlg 1 )

2|Paul White | 002 1973-03-11 Sales 2
3|Barry Green{003 1977-12-3(} Engineering 2

4|Jane Brown| 004 1980-11-03 Marketing 1

SQTaupe Qﬂ!_i)l%l-m;l‘.y Sales 3

Inputs

Two.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

¢ Select Top key column for the column you want to match in the top input dataset.

¢ Select Include top non-matching rows if you want to include in the output any rows in
the top input with no matching value in the bottom input.

¢ Select Bottom key column for the column you want to match in the bottom input
dataset.

e Select Include bottom non-matching rows if you want to include in the output any rows
in the bottom input with no matching value in the top input.

Top Include top non- Bottom Include top non- Also known as:

matching rows checked matching rows checked

No No Inner join

No Yes Right outer join

Yes No Left outer join

Yes Yes Full outer join
Notes

¢ Join merges two datasets side-by-side (horizontally). To merge datasets one on top of the
other (vertically) use Stack.

o If there are 10k rows or less in both datasets, Easy Data Transform will try to guess
sensible default values for Top key column and Bottom key column based on column
header names and contents.
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All values are treated as text and comparisons are case and whitespace sensitive. You can

use Case to change the case and Whitespace to remove whitespace before the intersect.

e If a key value occurs M times in the first dataset and N times in the second dataset, you
will get M x N rows with this key value. You can use Unigue to remove rows with duplicate
key values.

e Use Concat Cols to join several columns together (e.g. ‘first name' and 'last name'
columns) to form a key column.

e Use Row Num to create a unique key column.

e Use the Cross transform for cross joins.

Cascade multiple joins to join more than 2 datasets.

customers.csv |
o
1l ®Es ¥ rowd
Join
o

28 mE w330 Mws

v arders.csv

1% cam W B3O fawn

See also
¢ Video: How to join Excel files
e Cross

e Lookup
e Interpolate
e Merge datasets

2.3.24 Lookup

Description

Looks up the values of a column in the top input dataset in the bottom input dataset and
puts the result in a new column.
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Example

If you have one dataset with category IDs and another dataset with category IDs and
category names, you can create a new category name column in the first dataset by looking
up the category ID in the second dataset.

First dataset:

ProductlD ProductName Supplier]D CategorylD
11 Chai 1 1
12 |12 Chang 1 1
3 3 Aniseed Syrup 1 2
!4 4 Chef Anton's Cajun Seasoning 2 2
55 Chef Anton's Gumbo Mix 2 2

Second dataset:

CategorylD |CategﬁnrName Description
11 Beverages Soft drinks coffees teas beers and ales
22 Condiments  Sweet and savory sauces relishes spreads and seasonings
33 Confections Desserts candies and sweet breads

Lookup transform:

products.csv

4 cols x 77 rows

v Lookup

S cols x 77 rows

categories.csv

3 cols x8 rows
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Result:

11

2 |2

Inputs

Two.

Options

¢ Place the dataset you want to modify as the top input and the dataset you want to lookup

Lookup

Bottom values used: First

Mo match value:

Comment:

Ll o s w s v T Al s &

ProductlD ProductName

Chai

Chang

Aniseed Syrup

Chef Anton's Cajun Seasoning

Chef Anton’s Gumbo Mix

values from as the bottom input.
e Select Top lookup column for the column whose values you wish to lookup.

¢ Select Bottom lookup column for the column that matches the lookup in the bottom

dataset.

Top lookup column:  CategorylD
Bottom lookup column:  CategorylD

Bottom value column: CategoryMName

SupplierlD CategorylD Lookup CategoryName

1

1l

If no match: Use no match value

1

I

@
%

Beverages

Beverages

Condiments

Condiments

Condiments

e Select Bottom value column for the column that contains the values.

¢ Set Bottom values used to First if you want use the first match in Bottom lookup
column and All if you want to use all matches.

¢ Set If no match to Use not match value or Leave unchanged depending on what you
want to do for values in Top lookup column that do not exist in Bottom lookup

column.
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¢ Set No match value to the value you want to use for values in Top lookup column that
do not exist in Bottom lookup column when If no match is set to Use no match value.

Notes

e Easy Data Transform will try to guess sensible default values for Top lookup column,
Bottom lookup column and Bottom value column.

e Bottom values used is only important if there are duplicate values in the Bottom lookup
column.

e If the first input has a header, this will be used for the output.

o All values are treated as text and comparisons are case and whitespace sensitive. You can
use Case to change the case and Whitespace to remove whitespace before the intersect.

e If you want to lookup values in multiple columns, use Concat Cols to join several columns
together to form new columns.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

See also
o |f

e Interpolate
e Join

2.3.25 New Col

Description
Adds a new column, filled with a given value.

Inputs
One.

Options
¢ Set New column value to the value for every cell of the new column. You can leave it
blank for an empty column.

Notes
e New columns are always added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

See also

e Copy Cols
e Remove Cols
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2.3.26 Num Format

Description
Change the number format in one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.

e Set Format to the new number format (see below).

e For the e, E, and f formats, Precision represents the number of digits after the decimal
point. For the g and G formats, Precision represents the maximum number of significant
digits (trailing zeros are omitted). For the s format Precision is ignored. The following
number formats are supported:

Format Meaning

€ Format as [-]9.9e[+]|-]999.
E.g. 1234567.89 is shown as 1.235e+06.

i Format as [-]9.9E[+]-]999.
E.g. 1234567.89 is shown as 1.235E+06.

£ Format as [-]9.9.
E.g. 1234567.89 is shown as 1234567. 89.

g Use e or f format, whichever is the most concise.
Use E or f format, whichever is the most concise.

s The shortest accurate representation for the given
number without exponents.
E.g. 1234567.00 is shown as 1234567.

e Check use group separators to include the group separators for your locale. E.g. to turn
1234567 to 1,234,567 for a UK or US locale.

e Set Non-numeric according to what you want to do with non-numeric values in
transformed columns.

Notes

e The Locale set in the Preferences window is used to decide how the number is
represented (e.g. group and decimal separators).
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e Non-numerical values are ignored.
¢ You can also use Extract and Pad to change the number of characters.

See also
e Date Format
2.3.27 Pad

Description
Pad text to a minimum length in one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Minimum length to the length you want values in selected columns padded to.
Values this length or longer are unaffected.

¢ Set Pad to Left or Right depending on where you want any padding characters added.

¢ Set Pad with to the character you want to pad with.

Notes
e Whitespace is counted when calculating length. You can use Whitespace to remove
whitespace before padding.

2.3.28 Pivot

Description
Creates a pivot table to summarise values for one or two columns.

Inputs
One.

Options
e Set Column to the column values you want to use as columns in your pivot table.
¢ Set Rows to the column values you want to use as rows in your pivot table.
¢ Set Values to the column you wish to summarize.
e Set Summarize by to how you wish to summarize the values:
o Sum show the sum of the values. Non-numeric and empty values are ignored.
o Maximum shows the largest value. Non-numeric and empty values are ignored.
o Minimum shows the smallest value. Non-numeric and empty values are ignored.
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o Average shows the arithmetic mean of the values. Non-numeric and empty values are
ignored.
o Count shows the number of non-empty values. A value that contains whitespace is not
considered empty.
o Standard deviation is the sample standard deviation (equivalent to Excel function
stddev.s).
¢ Set Set non-calculated depending on how you want to set cells not calculated by the
pivot.
e Check add totals to add row and/or column totals,

See also
e Count
e Stats

e Summary
2.3.29 Remove Cols

Description

Removes columns.

Inputs
One.

Options

e Uncheck the column(s) you wish to remove.

Notes
e The column will be removed from any dataset 'downstream’.

See also
e New Col

2.3.30 Rename Col

This transform is deprecated. Use Rename Cols instead.

Description
Rename a column header.

Inputs
One.
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Options
e Select the column header you wish to rename in Column.
¢ Set Rename to to the new column header name.

Notes
e The names of column headers do not have to be unique.
2.3.31 Rename Cols

Description
Rename column headers.

Inputs
One.

Options

e Change the column headers using the New name column.

e Click Lower to change all the names in the New name column to lower case.

e Click Upper to change all the names in the New name column to upper case.

e Click Title to change all the names in the New name column to title case.

e Click Reset to change all the names in the New name column back to their original name.

Notes
e The names of column headers do not have to be unique.

2.3.32 Reorder Cols

Description
Reorder columns.

Inputs
One.

Options

Drag the columns into the desired order (left-most at the top).
Notes

You can also rename columns with Rename Cols and remove unwanted columns with
Remove Cols.
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2.3.33 Replace
Description

Replace text in one or more columns.

Examples
To turn 0123456789 into (+44) 1234 56789 using a Regular expression:

Match type: Regex H

Replace: O(\d\d\dd)(\d\d\d\d\d)
With: (+44)\1\2

To replace values that are empty or contain only whitespace with 0 using a Regular

expression:
Match type: Regex H
Replace: "s*%
With: 0
Inputs
One.
Options

e Check the column(s) you wish to transform.

e Choose whether to use text or Regular expression matching.

¢ In Replace put the text you want to replace. You can use a column variable.

¢ In With put the text you want to replace it with. You can use a column variable.

Notes
e Comparisons are case and whitespace sensitive. You can use Case to change the case and
Whitespace to remove whitespace before replacing.

See also

e Insert
e Substitute
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2.3.34 Row Num

Description
Add a new column that contains the row number.

Inputs
One.

Options

e Set Start at to the number you want to use for the first row.

¢ Set Increment to the amount you wish to increment by.

¢ set Every to how often to apply the increment (e.g. set to 5 to increment once every 5
rows).

Notes
e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

2.3.35 Sample

Description
Selects a subset of rows from the input.

Inputs
One.

Options

e Set Rows to the number of rows you want to output. If it is the same or greater than the
number of rows in the input, then the input will be unaffected.

¢ Set Select depending on how you want the rows sampled.

¢ Check Disable sampling to turn off sampling. If sampling is disabled, the transform does
nothing.

Notes

e If you are transforming a large dataset, then you can use Sample to test a small subset.

e If you need to do something more complex than Sample can handle (e.g. keep only rows
500 to 1000) then use Row Num followed by a Filter. For the most complex cases use
Row Num, followed by Javascript, followed by a Filter. E.g. this Javascript function
returns 1 for every 10th row between 1000 and 2000 and 0 otherwise:

return $(Row Num) >= 1000 & $(Row Num) <= 2000 & $(Row Num) % 10 == 0;
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2.3.36 Sort

Description
Sorts rows by one or more columns.

Inputs
One.

Options

e Click the '+' button to add a new sort level.

e Click the 'x' button to delete the selected sort level(s).

e Click the up arrow to move the selected sort level(s) up.

¢ Click the down arrow to move the selected sort level(s) down.

e Set Column to the column you want to sort by.

¢ Set Order depending on whether you want to sort this column Ascending or
Descending.

Notes

e If you add multiple levels, it will sort by level 1 then level 1 values that are the same will be
sorted by level 2 etc.

e Number, date and text values are treated differently for comparison purposes.

¢ Any values that can be converted to numbers will be treated as numbers.

e Any values that match the supported date formats in Preferences will be treated as dates.

e Comparisons of text are case and whitespace sensitive. You can use Case to change the
case and Whitespace to remove whitespace before filtering.

2.3.37  split Col

Description
Creates one or more new columns by splitting text at delimiters in a selected column.

Inputs
One.

Options

¢ Select the Column you wish to split.

e Supply the Delimiter you wish to use to split the column.

¢ Set Ordering depending on how you want to order values after splitting.

e Check keep empty if you wish to honor delimiters with nothing in between.

¢ set Min. new cols to the minimum number of new columns you wish to add.

¢ set Max. new cols to the maximum number of new columns you wish to add (ignored if
less than minimum).
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Notes

e If no Delimiter is supplied then no new columns are created.

e New columns are added at the right end. You can change the column order with Reorder
Cols.

o If there is a header, the header of the new column is based on the original header. You
can change the column name with Rename Cols.

e The opposite of Split Col is Concat Cols.

See also
e Split Rows

2.3.38 Split Rows

Description
Split each row into multiple rows.

Example
Splitting these rows:

| Guest title Guest first name Guest last Spouse title Spouse first name Spouse last name

1 Mr John Smith Dr Jane Smith

2 Mr Bill Brown Mrs Andrea Brown

Before each column containing 'title":

Split Rows

© when column name c ﬂ title

Gives:
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Guest title Guest first name Guest last

1 Mr John Smith

3 Mr Bill Brown

4 Mrs Andrea Brown

Inputs
One.

Options
e Split by column name:
o Each row will be split before each column that matches the criteria. The matching is
sensitive to case and whitespace.
e Split a fixed number of times:
o Define the number of times you want to split each row, starting at which column and
then every N columns.
o The split is added before the designated columns.
o Splits after the last column are ignored. So you can set times to a large number if you
don't know how many columns there will be.
¢ Split automatically:
o Find the first column name that appears more than once and split each row before each
column with that name.

Notes

¢ Splits added before the first column are ignored, as there is already a split there.

e Use New Col or Rename Cols if you need to add additional columns or rename columns
before splitting rows.

e The opposite of Split Rows is Concat Rows.

See also
e Gather

e Split Col
2.3.39 Spread

Description
Spread a column into multiple new columns. Also called wide pivot or crosstab.
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Example

salesman area Quarter Amount

1 Alice North Q1 11.3
2 Alice North H ;
3 Alice North Q3 E
4 Alice North E ;
5 Bob East Q1 4.5
6 Bob East 79
7 Bob East 8
8 Bob East 33
With Quarter and Amount columns spread:
Spread @ |3
Key column: Quarter o
Value column:  Amount E
Gives:
salesman area QITIQ2NIQ3 G4
1Alice  North 113 1893 443 18
2 Bob East 45 79 8 3.3
Inputs
One.
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Options

Select the Key column and Value column you wish to spread.

Missing values is used for values missing from the input dataset.

set Min. new cols to the minimum number of new columns you wish to add.

set Max. new cols to the maximum number of new columns you wish to add (ignored if
less than minimum).

Notes
e If there are rows that are duplicates, apart from the value column, this will cause errors.
e New columns are added at the right end. You can change the column order with Reorder
Cols.
¢ You can merge the new columns into a single column with Concat Cols.
¢ The opposite of Spread is Gather.
2.3.40 Stack

Description
Stack the rows from inputs, one on top of the other.

Example
Stacking these two datasets by the ID column in each:

Name DOB
John Black 001 01/07/1966

Paul White 002 11/03/1973

Barry Green 003 30/12/1977

MName DOB
Jane Brown 004 03/11/198

|
|
! Jill Taupe 005 01/03/198

Gives:
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Name ID DOB
1@1_:1 Black 001 1966—{]?—;1\

2[Paul White 002 1973-03-11

3 wry Green 003 19??—12—_59

4 Jane Brown 004 1980-11-02\

SlillhTaupe 005 1981-03-[_}})

Inputs

One or more.

Options

¢ Select Align columns by to Header name if you want line up column values by header
name (e.g. the 'id' column in input 1 with the 'id' column in input 2) and Column number
to align by the column number (e.g. the first column of input 1 with the first column of
input 2). The headers will be matched case insensitive (e.g. 'id' to 'ID"), if no case sensitive
match is possible.

e The output depends on the vertical (Y-axis) position of the inputs.

Notes

e Stack merges two datasets one on top of the other (vertically). To merge datasets side-by-
side (horizontally) use Join.

e If you align by Column number the header of the first input is used.

See also

e Cross

e Join

e Merge datasets
2.3.41 Stamp

Description
Adds a time/date stamp as a new row or a new column.

Inputs
One.
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Options

e Supply the processing date/time format in Format (see below).

Format

d

dd

ddd

dddd

MMM

Yy

YYYY

hh

Meaning

The day as number without a leading
zero (1 to 31)

The day as number with a leading zero
(01 to 31)

The abbreviated localized day name
(e.g. '‘Mon' to 'Sun’). Uses the system
locale to localize the name.

The long localized day name (e.g.
‘Monday' to 'Sunday'). Uses the system
locale to localize the name.

The month as number without a leading
zero (1to 12).

The month as number with a leading
zero (01 to 12)

The abbreviated localized month name
(e.g. 'Jan' to 'Dec’). Uses the system
locale to localize the name.

The long localized month name (e.g.
‘January' to 'December’). Uses the
system locale to localize the name.

The year as two digit number (00 to 99).

The year as four digit number. If the
year is negative, a minus sign is
prepended in addition.

The hour without a leading zero (0 to
23 or 1 to 12 if AM/PM display).

The hour with a leading zero (00 to 23
or 01 to 12 if AM/PM display).

Easy Data Transform © 2020 Oryx Digital Ltd



Reference

Format Meaning

H The hour without a leading zero (0 to

23, even with AM/PM display).

HA The hour with a leading zero (00 to 23,

even with AM/PM display).

The minute without a leading zero (0 to
59).

The minute with a leading zero (00 to
59).

The whole second without a leading
zero (0 to 59).

s The whole second with a leading zero

where applicable (00 to 59).

The fractional part of the second, to go
after a decimal point, without trailing
zeroes (0 to 999). Thus "s.z" reports the
seconds to full available (millisecond)
precision without trailing zeroes.

AP or A The fractional part of the second, to

millisecond precision, including trailing.
ap or a

Use am/pm display. a/ap will be
replaced by either "am" or "pm".

The timezone (for example "CEST").

¢ Select from Position whether you want the stamp row added to the start or end of the
dataset or to every row in a new column.

Notes
e If you add the stamp to Every Row you can move the column using Reorder Cols.

See also
e Meta information
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2.3.42 Stats

Description
Calculates the sum, minimum, maximum, average, median or standard deviation of numeric
values by column or row in one or more selected columns.

Inputs
One.

Options
e Check the column(s) you wish to calculate stats for.
¢ Set Calculation to the statistic you want to calculate.
e Set On depending on whether you wish to calculate the statistics for columns, rows or
both.
o If On is set to Columns an extra row with the results is added to the bottom.
o If On is set to Rows an extra column with the results is added to the right.
o If On is set to Columns and rows an extra row with the results is added to the bottom
and extra column with the results is added to the right. The bottom right cell
contains the calculation across all values.

Notes

e The average is the arithmetic mean.

e The standard deviation is the sample standard deviation (equivalent to Excel function
stddev.s).

e Non-numerical and empty values are ignored.

e Use Num Format to change the precision of the results.

See also

e Count

e Pivot

e Summary
2.3.43 Substitute

Description

Substitute column values into text.

Example
To create SQL statements to insert 'Country’, 'Year', 'Key' and 'Value' column values:

INSERT INTO mytable (Country,Year,Key,Value) VALUES ($(Country),$(Year),$(Key),$ (Value
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Substitute I s

New column name: SQL

Substitution script:

INSERT INTO mytable(Country,Year,Key,Value) VALUES (5(Country),S(Year),$(Key), ${Value));

Insert variable: <select> H Evaluate

Comment:

Substitute column values into text.

L& 7
Country Year Kay Value SQL
1 Afghanistan 1999 cases 745 INSERT INTO mytable(Country,Year Key,Value) VALUES (Afghanistan,1999,cases, 745);
Inputs
One.
Options

e Enter your substitution script into the Substitution script field.

e Select a column from Insert variable to add that column variable into the Substitution
script field at the current cursor position.

e Click the Evaluate button to evaluate your script over every row.

Notes
e The transform is calculated every time:
o The Evaluate button is pressed.
o The Substitute transform item is unselected in the Center pane and script changes
have been made without the Evaluate button being clicked.
o The item upstream of it changes.
e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.
e If you want to carry out your transform across more than one dataset, you should Join

them first.
e If you need to do something more complex than this transform allows, try the Javascript
transform.
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2.3.44 Subtract

Description
Remove rows from the top dataset with key values that are present in the lower dataset.

Inputs

Two.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

e Select Top key column for the column you want to match in the top input dataset.

¢ Select Bottom key column for the column you want to match in the bottom input
dataset.

Notes

e If there are 10k rows or less in both datasets, Easy Data Transform will try to guess
sensible default values for Top key column and Bottom key column based on column
header names and contents.

o If the first input has a header, this will be used for the output.

e All values are treated as text and comparisons are case and whitespace sensitive. You can
use Case to change the case and Whitespace to remove whitespace before the subtract.

¢ Does not remove duplicates. You can use Unique to do this.

e You can use Concat Cols to join several columns together (e.g. 'first name' and 'last name’
columns) to form a key column.

e You can use Row Num to create a unique key column.

See also
e Intersect

2.3.45 Summary

Description
Summarise the values in the selected columns.

Inputs
One.

Options

e Select the Columns you wish to summarise.

e Check check for dates if you wish to check for date values using supported date formats.
This can be slow for large datasets.
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Notes

e Empty values is the number of values in the column that are completely empty. Values
with whitespace do not count as empty.

¢ Numeric values is the number of numeric of values in the column that can be interpreted
as a number.

¢ Date values is the number of values in the column that can be interpreted as a date. Only
shown if check for dates is checked.

¢ Text values is the number of values in the column that cannot be interpreted as empty,
numeric or date.

¢ Unique values is the number of unique values in the column. Empty values are not
counted. Date and numeric values are treated as text (e.g. '7' is treated as different to '7.0'
and '1/1/2020" is treated as different to '01/01/2020"). Comparison between values is
sensitive to case and whitespace.

¢ Min length is the minimum number of characters of a value in the column. Whitespace is
counted. Date and numeric values are treated as text.

e Max length is the maximum number of characters of a value in the column. Whitespace is
counted. Date and numeric values are treated as text.

¢ Min numeric is the minimum numeric value in the column.

e Max numeric is the maximum numeric value in the column.

¢ Min date is the minimum date value in the column. Only shown if check for dates is
checked.

¢ Max date is the maximum date value in the column. Only shown if check for dates is
checked.

¢ Most frequent lists the most common text in the column. Empty values are not counted.
Date and numeric values are treated as text. Comparison between values is sensitive to
case and whitespace.

e You can use Whitespace to remove any whitespace at the start or end of values before
Summary.

e If you wish to have a row displayed per column you can Transpose the table.

See also

 Count

e Pivot

e Stats
2.3.46 Total

Description
Add a new column with a running (cumulative) total of the selected column.
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Inputs
One.

Options

e Set Column to the column you want to total.

Notes

e Non-numerical values are ignored.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

See also

 Count

e Pivot

e Stats
2.3.47 Transpose

Description
Swap (rotate) rows and columns, so that each row becomes a column and each column
becomes a row.

Inputs
One.

Options

e Check has header to make the new first row into a header (requires >1 row).

Notes

e If the input dataset has a header, it will become the new first column. Use Remove Cols to
remove it.

e Datasets with very large numbers of columns can be slow to display.
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2.3.48 Trim

This transform is deprecated. Use Whitespace instead.

Description
Removes leading and trailing whitespace from one or more columns.

Inputs
One.

Options
e Check the column(s) you wish to transform.
2.3.49 Unique

Description
Remove duplicate rows based on keeping only unique values in selected columns

Example
If you have a dataset of orders:

Name Customer Id Product Id Cost Date
1 Alice Anderson C018930 13574 29.95 01/10/2020

2 Bob Brown 89456 10.55 01/10/2020
3 Charlie Jones CO17783 96352 19.95 02/10/2020 |

4 Robert Brown

98526 10.00 02/10/2020

5 Charles Jones CO17783 38746 25.00 03/10/2020}

And you want to:

e keep one row per unique Customer Id

keep the first listed Name for each Customer Id

e concatenate Product Ids for each Customer Id, delimited by a comma
sum the Costs for each Customer Id

keep the latest Date for each Customer Id
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e add a Count column showing how many rows in the input correspond to each row in the
output
You can set the following:

Unique @& 23
Column Option
MName Keep first ki
Customer Id Keep unigque H
Product Id Concat %]
Cost Sum 2]
Date Maxirmum T
Set Al i Keepunique [
Keep unique for 1 of 5 columns
Concat delimiter: ,
add count column

To get:
Name Customer Id Productld Cost Date Count
1 Alice Anderson C018930 13574 29.95 01/10/2020 1
2 Bob Brown 89456,98526 20.55 02/10/2020 2
3 Charlie Jones CO17783 96352,38746 44,95 03/10/2020 2

Inputs
One.

Options
e Set an Option for each column:
o Only 1 row is kept where all the Keep unique columns have the same value.
o Keep first keeps first value in the current sort order.
o Keep last keeps the last value in the current sort order.
o Sum sums any numerical values. Blank values are ignored.
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o Maximum keeps the maximum numerical or date value.
o Minimum keeps the minimum numerical or date value.
o Average takes the average (mean) of any numerical values. Blank values are ignored.
o Concat to concatenate values. Duplicate values are kept. All values are treated as text.
o Concat unique to concatenate values. Duplicate values are ignored. All values are
treated as text.

¢ Use the Set button to quickly set the option value for multiple columns.

¢ Set Concat delimiter if you want to add a delimiter between Concat or Concat unique
values

¢ Check add count column to add a column showing how many rows in the input dataset
created each unique row.

Notes

e Rows are considered duplicates if they have exactly the same value in all the columns set
to Keep unique. Comparisons are case and whitespace sensitive. You can use Case and
Whitespace to change case and whitespace before deduping.

e If no columns are set to Keep unique the transform won't do anything.

e If you are using Keep first or Keep last the sort order is important. You can use Sort to
change the sort order before deduping.

See also
e Dedupe a dataset
2.3.50 Whitespace

Description
Tidy whitespace (spaces, tabs, carriage returns etc) in the selected column(s).

Inputs
One.

Options

e Check the column(s) you wish to transform.

e Check Trim leading and trailing whitespace to remove whitespace characters, such as
space and tab.

e Check Replace line feeds with spaces to replace LF (\n) characters with spaces.

e Check Replace tabs with spaces to replace tab (\t) characters with spaces.

e Check Remove carriage returns to remove CR (\r) characters.

e Check Convert consecutive spaces to one space to replace 2 or more consecutive spaces
with a single space.
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e Check Remove non-printable characters to remove characters of Unicode type Other_*.
This include ASCII codes 0 to 31, such as tab, line feed, carriage return, bell and
backspace. It does not remove spaces.

Notes
e The operations are carried out in top to bottom order, e.g. Replace line feeds with
spaces is carried out before Convert consecutive spaces to one space.

See also
e Case

2.4 Output
24.1 Output data

Once you have finished transforming your data you can output it in the following formats:
o CSV

e Excel

* JSON

e HTML

e Markdown

o TSV

» vCard

o XML

e YAML

To create an output, select 1 input and/or transform item in the Center pane and then click
the To File button at the bottom of the Left pane. You can choose the file type in the file
type drop-down list of the Output window.

You can select the output item in the Center pane and change any options related to the
output in the Right pane.
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output.csv @ ﬁf E :
File: /Users/andyb/Desktopfoutput.csv
Type: Delimited text o
Delimiter: Comma (,) H
Encoding: UTF-8 a
Byte Order Mark
Write mode:  Owverwrite H
Alias: output
Comment:

Set File to the location of the file you want to output. If you are writing to a .xIs or .xlsx file
the output will be written to a sheet called 'Easy Data Transform' by default. You can change
this by adding the sheet name inside [], e.g. myfile.xlsx [mysheet].

Set Type to the file type. The default type will be set according to the file extension and the
settings in the Output Extensions tab of the Preferences window.

Set Delimiter to the delimiter you wish to use (only available for delimited text files, such as
CSV and TSV).

Set Encoding to the text encoding you wish to use (only available for text files).

Set Format as depending on how you want to set the Excel formatting of cells (only
available for Excel files).

Set Byte Order Mark checked write a Unicode Byte Order Mark to the file (only available
for UTF encodings).

Set Root name and Row name depending on the name you want to use for the root and
row XML records (only available for XML files).

Use Write mode to determine how existing files are treated:
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Write mode for File exists with File exists without File does not exist

Excel files named sheet named sheet

Overwrite / File Overwrite named Add named sheet, Create file with only
sheet, delete all delete all other named sheet
other sheets sheets

Overwrite / Sheet  Overwrite named Add named sheet Create file with only
sheet named sheet

Append Append to named Add named sheet Create file with only
sheet named sheet

New Do nothing Do nothing Create file with only

named sheet

Disabled Do nothing Do nothing Do nothing

Write mode for non-Excel File exists File does not exist

files

Overwrite Overwrite file Create file

Append Append to file Create file

New Do nothing Create file

Disabled Do nothing Do nothing

Use Alias to identify the file for batch processing.

Use Comment to record any notes that might be useful to a colleague or your future self.

2.5 File formats
2.5.1 File formats

Easy Data Transform supports the following data file formats:

Format Input Output

Delimited text (including Yes Yes
CSV and TSV)

Excel XLSX/XLS Yes Yes
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Format Input Output
Fixed width Yes No
JSON Yes Yes
HTML No Yes
Markdown No Yes
vCard Yes Yes
XML Yes Yes
YAML No Yes

You can manage the default file type for different file extensions in the Input Extensions
and Output Extensions tabs of the Preferences window.

2.5.2 CSV format

Easy Data Transform can input from and output to CSV format files. Default file extension

.CSV'.

CSV (Comma Separated Value) format is commonly used for exchanging tabular data
between programs.

CSV is a type of delimited text file format. Carriage return denotes the end of a row. The
column delimiter is usually commas, but not always.

Easy Data Transform supports the following column delimiters:
e comma (,)

semi-colon (;)

colon ()

pipe (|)

caret (M)

For all the above delimiters:

e If a value field contains a quote (") character, then the quote will be ‘escaped' by an
additional quote when output.

o If a value field contains a delimiter, quote or carriage return character, then the value be
surrounded by quotes (") when output.

For example:

Easy Data Transform © 2020 Oryx Digital Ltd



Reference

| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 g Condiments Sweet and savory sauces false
i 33 Confections Candies and sweet breads true

Is output as:

CategoryID, CategoryName, Description,In stock
1,Beverages, "Soft drinks, coffees & teas", true
2,Condiments, Sweet and savory sauces, false
3,Confections,Candies and sweet breads, true

Many CSV file are not well formed. For example, they have unescaped quotes. As the CSV
format is not well-defined, badly formed CSV files can be interpreted in more than one way.
Easy Data Transform will do the best it can in these circumstances.

Tab delimited (TSV) files are treated a bit differently.

2.5.3 Excel format

Easy Data Transform can input from and output to Excel ".xlsx" and "xIs" format files, even if
you don't have Excel installed.

Excel format is the native format of the Microsoft Excel spreadsheet application. It is
commonly used for exchanging tabular data.

You can specify the sheet name when inputting or output Excel files using square brackets,
eg.MySpreadsheet.xlsx[Sheetl]IﬂeanssheetSheetlCﬁf”eNWSpreadsheet.xlsx.

Note that:

e Excel .xlsx files are limited to 1,048,576 rows and 16,384 columns.

e Excel .xls files are limited to 65,536 rows and 256 columns.

¢ The following characters are not allowed in sheet names:\ / * [ 1 : 2

2.5.4  Fixed width format
Easy Data Transform can input from fixed width format files, also known as fixed column

width format. Default file extension ".txt".

Fixed width format is used for exchanging tabular data between programs. It is often
associated with legacy systems, but is also used for large files where performance is an issue
(e.g. bioinformatics).
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In fixed width format each column has a fixed width in characters. There is no delimiter.
Spaces are typically used as padding to make up the column width. For example:

ID Name Payment Country Date
8904 John Black 12345.67 GB 08/20/2020
3999 Jane Brown 23456.78 US 08/20/2020
7489 Zadie Green 34567.89 DE 08/20/2020
Is input as:

| ID Name Payment Country Date

1 8904 John Black 12345.67 GB 08/20/2020

2 3999 Jane Brown 23456.78 U5 08/20/2020

:3 7489 Zadie Green 34567.89 DE 08/20/2020

Easy Data Transform will analyze the data and guess the column layout if you set Columns
in the right pane to Automatic. Or you can choose the column widths by setting Columns
to Manual. Click the "..." button to edit the manual column widths.
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fixed-example.txt @\ e
File: /Usersfandyb/Dropbox/fixed-example.txt
i -
¢ Columns: Manual M -
[ ] O] Fixed Column Widths
Width Starts at Ends at
Column1 |6 -1 6
Column 2 13 o 7 19
Column 3 10 - 20 29
Columnd 9 - 30 38
Column5 10 - 39 48
Merge Split Insert Left Insert Right Delete Columns: 5
Preview
Q00000000111111111122222222223333333333444444444
12345678901 2345678901 234567890123456789012345678
ID Name Payment Country Date
B904 John Black 12345.67 GB 08/20/2020
3999 Jane Brown 23456.78 Us 0a8/20/2020 *
7489 Zadie Green 34567.89 [DE 0a/20/2020

Help Cancel “

The current column boundaries are shown on the first few rows in the Preview. The
horizontal offset of each character is shown in gray at the top. The currently selected
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columns are highlighted. Click on a column in the Preview to select it in the table, or vice
versa.

You can change the column widths using the Width column of the table.

Select 2 or more adjacent columns and click Merge to merge them into 1 column. Click
then Shift+click in either the table or the preview to select multiple adjacent columns.

Select 1 column with a Width > 1 and click Split to split into into 2 columns.

Select 1 or more adjacent columns and click Insert Left or Insert Right to add a new
column with width 1 to the left or right of the selected columns.

Select 1 or more adjacent columns and click Delete delete the selected columns.
Click OK to save your changes and Cancel to discard them.

Unwanted columns and rows in the dataset can be removed after input using the Remove
Cols and Filter transforms.

2.5.5 JSON format
Easy Data Transform can input from and output to JSON format files. Default file extension

"json".

JSON (JavaScript Object Notation) format is commonly used for exchanging data between
programs. JSON data is expected to be in UTF8 encoding.

For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
1212 Condiments Sweet and savory sauces false
|
|
| 33 Confections Candies and sweet breads true

Is equivalent to:

[
{

"CategoryID": "1",
"CategoryName": "Beverages",
"Description": "Soft drinks, coffees & teas",
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"In stock": "true"

bo

{
"CategoryID": "2",
"CategoryName": "Condiments",
"Description”: "Sweet and savory sauces",
"In stock": "false"

b

{
"CategoryID": "3",
"CategoryName": "Confections",
"Description”: "Candies and sweet breads",
"In stock": "true"

The dot ('.") character is used in the column header to show nesting. For example:

name carb cholesterol fiber minerals.ca minerals.fe protein sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is equivalent to:

"name": "Avocado Dip",
"carb": "2",
"cholesterol": "5",
"fiber": "O",
"minerals": {

"Ca": "O",

"fe". "O"
|
"protein": "1",
"sodium": "210",
"vitamins": {

"a": "O",

"c". "O"

Any dots in JSON names are converted to hyphens ('-') on input.

JSON arrays can be input in either long or wide Format. For example:

"name": lllll,

"Values": [ "a", "b" ]
s
{

"name": "2",

"Values": [ IIC", lldll ]
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Input as Long (more rows):

name values
11 a
2|1 b
32 C
|42 d

Input as Wide (more columns):

name values.0 values.1

11 a b

22 c d

2.5.6 HTML format

Easy Data Transform can output to tables in HTML format files. Default file extension
" html".

HTML (HyperText Markup Language) format is commonly used for creating web pages. If
you don't need the data to take up a whole page, you can just copy the <table> to
</table> part of the output.

For example:
| CategorylD CategoryMame Description In stock
11 Beverages Soft drinks, coffees & teas true
1212 Condiments Sweet and savory sauces false
|
|
| 33 Confections Candies and sweet breads true
Is output as:
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<!DOCTYPE html>
<html>
<head>
<meta charset="UTF-8"/>
<title>C:\Users\andyb\Desktop\output.html</title>
<style>table, td, th{border:1px solid black;text-align:left;vertical-align:top;bord
</head>
<body>
<table>
<tbody>
<tr>
<th>CategoryID</th>
<th>CategoryName</th>
<th>Description</th>
<th>In stock</th>
</tr>
<tr>
<td>1</td>
<td>Beverages</td>
<td>Soft drinks, coffees &amp; teas</td>
<td>true</td>
</tr>
<tr>
<td>2</td>
<td>Condiments</td>
<td>Sweet and savory sauces</td>
<td>false</td>
</tr>
<tr>
<td>3</td>
<td>Confections</td>
<td>Candies and sweet breads</td>
<td>true</td>
</tr>
</tbody>
</table>
</body>
</html>

2.5.7 Markdown format

Easy Data Transform can output to tables in Markdown format files. Default file extension
ll.mdll‘

Markdown format is commonly used as a human-friendly markup language, which can be
automatically translated to HTML.

For example:
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| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true

1212 Condiments Sweet and savory sauces false

|

I

| 33 Confections Candies and sweet breads true
Is output as:
| CategoryID | CategoryName | Description | In stock |
| === [ === [ == e e e | —========= |
|1 | Beverages | Soft drinks, coffees & teas | true
| 2 | Condiments | Sweet and savory sauces | false
| 3 | Confections | Candies and sweet breads | true

You can also use Markdown when you need a plain text version of your data, for example in
a code comment.

Note that not all Markdown implementations support tables. If your implementation does
not support tables, you may need to output to HTML instead.

2.5.8 TSV format

Easy Data Transform can input from and output to TSV format files. Default file extension

tsv.

TSV (Tab Separated Value) format is commonly used for exchanging tabular data between
programs.

TSV is a type of delimited text file format. Values are separated by tab characters. Tabs are
not allowed within data values, so there is no need for quoting or escaping delimiters, as
with CSV files. This means that TSV files are generally a bit more compact and faster to read
and write than CSV files.

If you have a tab character in a value, Easy Data Transform will convert it to a space on
output.

2.5.9 vCard format

Easy Data Transform can input from and output to vCard format files. Default file extension
"vcf".

VCard format is commonly used as way of exchanging contact details between programs.
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Note that you need to change the column header names to the values expected by vCard
(using the Rename Cols transform).

For example:
N FN ORG TELTYPE=WORK,VOICE  ADR;TYPE=WORK, PREF
1 Gump;Forrest;Mr.; Forrest Gump Bubba Gump Shrimp Co. (111) 555-1212 100 Waters Edge;Baytown;

Is equivalent to:

BEGIN:VCARD

VERSION:3.0

N:Gump; Forrest;;Mr.;

FN:Forrest Gump

ORG:Bubba Gump Shrimp Co.

TEL; TYPE=WORK,VOICE: (111) 555-1212

ADR; TYPE=WORK, PREF:100 Waters Edge;Baytown;LA;30314;United States of America
END:VCARD

2.5.10 XML format

Easy Data Transform can input from and output to XML format files. Default file extension
" xml".

XML (Extensible Markup Language) format is commonly used for exchanging data between
programs.

For example:

| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 2 Condiments Sweet and savory sauces false
i 33 Confections Candies and sweet breads true

Is equivalent to:

<?xml version="1.0" encoding="UTF-8"?>
<root>
<record>
<CategoryID>1</CategoryID>
<CategoryName>Beverages</CategoryName>
<Description>Soft drinks, coffees &amp; teas</Description>
<In-stock>true</In-stock>
</record>
<record>
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<CategoryID>2</CategoryID>
<CategoryName>Condiments</CategoryName>
<Description>Sweet and savory sauces</Description>
<In-stock>false</In-stock>

</record>

<record>
<CategoryID>3</CategoryID>
<CategoryName>Confections</CategoryName>
<Description>Candies and sweet breads</Description>
<In-stock>true</In-stock>

</record>

</root>

The dot ('.") character is used in the column header to show nesting. For example:

name carb cholesterol fiber minerals.ca minerals.fe protein sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is equivalent to:

<?xml version="1.0" encoding="UTF-8"?>
<root>
<record>
<name>Avocado Dip</name>
<carb>2</carb>
<cholesterol>5</cholesterol>
<fiber>0</fiber>
<protein>1</protein>
<sodium>210</sodium>
<minerals>
<ca>0</ca>
<fe>0</fe>
</minerals>
<vitamins>
<a>0</a>
<c>0</c>
</vitamins>
</record>
</root>

Any dots in XML element names are converted to hyphens ('-') on input.

The underscore ('_") character is used at the start of a column header name to identify it as
an XML attribute. For example:

_name _carb _cholesterol _fiber minerals.ca minerals.fe _protein _sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is equivalent to:

<?xml version="1.0" encoding="UTF-8"?>
<root>
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<record carb="2" cholesterol="5" fiber="0" name="Avocado Dip" protein="1" sodium="2
<minerals>
<ca>0</ca>
<fe>0</fe>
</minerals>
<vitamins>
<a>0</a>
<c>0</c>
</vitamins>
</record>
</root>

Repeated XML values can be input in either long or wide Format. For example:

<?xml version="1.0" encoding="UTF-8"7?>
<ITEMS>
<ITEM>
<PARAM name="a" value="1"/>
<PARAM name="b" value="2"/>
</ITEM>
</ITEMS>

Input as Long (more rows):

PARAM._name PARAM. value
1b 2

2a 1

Input as Wide (more columns):

PARAM. _value PARAM._name PARAM._value.l PARAM._name.l
11 a 2 b

You are responsible for ensuring that the names of XML nodes and attributes are valid (e.g.
start with a letter or underscore and do not contain spaces).

2.5.11 YAML format

Easy Data Transform can output to YAML format files. Default file extension ".yaml".

YAML (YAML Ain't Markup Language) format is commonly used for exchanging data
between programs and for configuration files.

For example:
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| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 2 Condiments Sweet and savory sauces false
i 33 Confections Candies and sweet breads true

Is output as:

CategoryID: 1

CategoryName: Beverages

Description: Soft drinks, coffees & teas
In stock: true

CategoryID: 2

CategoryName: Condiments
Description: Sweet and savory sauces
In stock: false

CategoryID: 3

CategoryName: Confections
Description: Candies and sweet breads
In stock: true

2.6 Headers

If the first row of an input is a header (i.e. one that describes the columns below) check has
header for that input in the Right pane.
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KA
|

testl.csv @

File: /Usersfandyb/Dropbox/testl.csv

Delimiter: Automatic

Encoding: Automatic

. & @

Ignore: Fir

simplify whitespace
ignore empty rows
watch file

Alias: test1

Comment:

22 cols x 64 rows

ClB & Show first 10 rows  [i§)

title first name last name suffix meal spe@

When you first read in a dataset Easy Data Transform will make a guess about whether the
first row is a header (it will assume it is a header if it contains no dates or numbers).

You can move 1 or more dataset rows to the header using the Header transform.
2.7 Connections

When you select an input or transform item and add a transform or output item,
connections are added automatically.

To select a connection

To select a connection either:

e Click on the connection; or

e Click and drag a box over any part of the connection. This may be easier than clicking the
connection when you are zoomed back.

transactions.x...

Yy, Filter

35 cols x 53.3k rows L} 35 cols x 53.3k rows
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To delete a connection

To delete a connection:

¢ Select the connection.

e Select Edit>Delete (or click the Delete tool bar button).

Note that deleting a connection may unset column related parameters downstream, so

should generally be avoided where possible.

e If you want to change an input file, do it by selecting the input and clicking on "..." in the
Right pane, rather than disconnecting the input and connecting a new one.

e If you want to add a new transform between 2 already connected items, you can do it
without disconnecting (see below).

To add a transform to a connection

To add a transform between two already connected items:

e Select the connection.

e Choose the new transform from the Left pane or using the right click menu.

/" COVID-19-ge..
‘\/[COVID—lQ—ge...

11 cols x 14.7k rows 11 cols x 14.7k rows

Dedupe

To add a connection
To add a new connection between two existing items:
e Hover over the start item.
e Click the '+' that appears.

Filter

transactions.x...

%)

lick to connect from this item.

35 cols x 53.3k rows

e Hover over the end item
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e Click the '+' that appears.

Filter

transactions.x...

35 cols x 53.3k rows lick to connect to this item.

Press the 'Esc’ key or click away from an item to cancel adding the connection.

Note that the '+' will only appear if an additional connection is allowed. For example you
can't:

e Create a loop.

e Connect more than once from a transform.

e Connect more than once to an output.

2.8 Text

Whitespace (such as Space and Tab characters) and capitalization are always significant,
unless stated otherwise.

You can remove leading and trailing whitespace by checking trim whitespace in the Input
or using the Whitespace transform.

You can change the case using the Case transform.

2.9 Dates
Set the date formats you want to recognize in the Preferences window using the following
options:
Format Meaning
d The day as number without a leading
zero (1to 31)
dd The day as number with a leading zero
(01 to 31)
ddd

The abbreviated localized day name (e.g.
‘Mon' to 'Sun’). Uses the system locale to
localize the name.

Easy Data Transform © 2020 Oryx Digital Ltd



Reference

Format Meaning

drelelel The long localized day name (e.g.

'‘Monday' to 'Sunday'). Uses the system
locale to localize the name.

M The month as number without a leading
zero (1to 12).

L The month as number with a leading zero
(01 to 12)

MM The abbreviated localized month name
(e.g. 'Jan' to 'Dec’). Uses the system locale
to localize the name.

MMMM The long localized month name (e.g.
‘January' to 'December’). Uses the system
locale to localize the name.

vy The year as two digit number (00 to 99).

yyyy The year as four digit number. If the year
is negative, a minus sign is prepended in
addition.

For example:

e To support a date such as 31/1/2019 add a supported date format: d/M/yyyy
e To support a date such as 1-31-19 add a supported date format: M-d-yy

List the date formats in order of preference, with the most likely to be used first.

Note that dates with only two year digits, are treated as a date between 1900 and 1999. E.g.
"31/1/19" is interpreted in d-M-yy format as 31st January 1919.

Values that are in a recognized date format will be treated as dates in the Filter, If and Sort
transforms. Supporting large numbers of date formats will slow down these transforms.

You can change the format of dates using the Date Format transform and calculate the
difference between 2 dates using the Javascript transform.

2.10 Numbers

Easy Data Transform uses the locale set on your computer to decide what is a number. For
example, if your system locale is set to US or UK then "123.45" is a number and "123,45"
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isn't, and vice versa if your system locale is Germany or France.
2.11 Meta Information

You can add meta information to input data using the Meta info field in the Right pane
when you select an input item. Set it to At start, At end or Every row, depending on where
you want the meta information to appear. Then click on the ... button to edit which
information you wish to show. The following placeholders are substituted by their actual
values at the time of input.

Meta Information Description Example

$ (ComputerName) The name of the MyComputer
computer.

$ (CurrentDate) The current date, in 2020-08-18
ISO format.

$ (CurrentDateTime) The current 2020-08-
datetime, in ISO 18T18:00:00
format.

$ (DataColumns) The number of 10

columns in the
dataset (not
including meta
data).

% (DataRows) The number of row 10,000
in the dataset (not
including meta
data).

$ (DataValueS) The number of 100, 000

columns x rows in
the dataset (not
including meta
data).

$(FileCreatedDate) The date the file 2020-08-18

was created, in ISO
format. Only
available for file
input.
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Meta Information

S (FileCreatedDateTime)

S (FileName)

$ (FilePath)

$(FileSizeBytes)

S (FileUpdatedDate)

$(FileUpdatedDateTime)

S (UserName)

Easy Data Transform © 2020 Oryx Digital Ltd

Description

The datetime the
file was created, in
ISO format. Only
available for file
input.

The name of the
file, including it's
extension. Only
available for file
input.

The full path

(location) of the file.

Only available for
file input.

The size of the file
in bytes. Only
available for file
input.

The date the file
was last updated, in
ISO format. Only
available for file
input.

The datetime the
file was last
updated, in ISO
format. Only
available for file
input.

The name of the
user (from the
USER or
USERNAME
environment
variable).

Example

2020-08-
18T18:00:00

myfile.csv

/Users/andy/Do
cuments/myfile
.CSV

1,234,567

2020-08-18

2020-08-
18T18:00:00

Andy
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2.12 Column variables

Some transforms allow you to use the values of columns on the same row using column
variables. Column values can be referenced either:

e By column header name, e.g. $ (item cost) for the 'item cost' column; or
e By column index, e.g. s (1) for the first column.

Notes:

e The column name is case sensitive.

e Whitespace at the start or end of the column name is ignored.

e If multiple columns have the same name, the first from the left will be used.

e Reference by name takes priority over reference by index. For example, if there is a
column named "1" then s (1) will refer to that rather than the first column.

2.13 Regular expressions
Easy Data Transform allows the use of regular expressions in the replace, if and filter

transforms. It is also available as part of the Javascript language in the Javascript transform.

Regular expressions are a powerful way to match patterns in text (including text
representation of dates and numbers). For example, you can use a regular expression in the
Replace transform to swap first and last names:

Match type: Regex ﬁ
Replace: (\Ww+)\s*(\w+)
with: \2, \1
Turns:
Full name

1 John Smith

2 Mary Brown

3 Jill Jones
Into:
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Full name

1 Smith, John
2 Brown, Mary

3 Jones, Jill

Regular expressions are far too big a topic to cover here. However there are many detailed
resources online, such as www.regular-expressions.info and regexr.com.

2.14

Batch processing

To apply the current transform template file to multiple input files select File>Batch
Process... . The Batch Process window will appear with a column for each input item and a
column for each output item. The Alias for each item is displayed in the column header.

orders.csv

v

customers.csv

@

Input columns can in
E.g. '/Users/andyb/D
Qutput columns can
E.g. '/Usersfandyb/

Click "Help' for more

Add Remo

14 cols x 830 rows

11 cols x 91 rows

v, Join v,

24 cols x 830 rows

Batch Process

bcuments/*.csv' or '/Usery/andyb/Documents/data.xIsx[*]"
nclude: {customers}, {ordirs}, {date}, {time}, {datetime}:
cuments/{customers}_{datgtime}.csv'

details.

(-] Clear

Input alias=customers

Input alias=orders

output.json

24 cols x 830 rows

Output alias=output [Overwrite)

1 pbox/northwind/customers.csv | .. indyb/Dropbox/northwind/*.csv | .. |pfmergedfoutput_{anrs}.json

wildcard

Input file name
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Note:

¢ All input and output items must have an alias.

e An output item can't have the same alias as another output or input item.
e Output items with Write mode=Disabled are not shown.

Click Add to add a new processing row.

Click Remove to remove the selected processing row(s).

Click Clear to remove all processing rows.

In the (pink) input column you can use * and ? wildcards for file name stems, file extensions
and Excel sheet names. E.g.:

Input Description

/Users/andy/Documents/*.csv All files with extension
.csv in the Documents
folder

/Users/andy/Documents/d?.csv All the files with name

'd" plus a single
character in the
Documents folder

/Users/andy/Documents/data.x1lsx[*] All the sheets in

data.xlsx in the
Documents folder

/Users/andy/Documents/*.xlsx[data*] All the sheets
beginning with 'data’
in all the .xslx files in

the the Documents
folder

Note:

e If there is more than 1 input column that specifies multiple files or sheets, then an output
will be created for each possible permutation of input files/sheets in the row. E.g. 3 input
files from column 1 x 4 sheets from column 2 = 12 outputs to process.

e Excel sheet names are not case sensitive.

¢ You cannot use wildcards for folder names.

e Batch processing will ignore files in sub-folders.
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e All the files input to an input item or output from an output item should be the same file
type as the original.

In the (green) output column you can use the following variables to create your output file
name:

Output variable Meaning Example

{<input alias>} The name of the input  If input alias 'orders' is

file being processed in  using file
the column with the
corresponding alias.

{date) Date processing was ~ 2020_04_18

carried out in
year_month_day
format

{time}

Time processing was 15_21 56_599
carried out in

hours_minutes_second

s_milliseconds format

{datetime} Date/Time processing  2020_04_18_15_21_56_
was carried out in 599
year_month_day_hour
s_minutes_seconds_mil
liseconds format
format

Whether an ouput file is created, overwritten or appended to depends on the Write mode
of the output item.

Click Process to start processing the rows.
Click Stop to stop processing the rows.
Click Close to close the window.

See also:

e Batch processing examples
e Command line arguments
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2.15 Command line arguments

Easy Data Transform accepts the following command line arguments:

Argument Description

<file name> The .transform file to open at

start-up.

e Close the application once

any processing on the
opened file is complete.

—file <alias>=<location> Sets the input or output file

with the given alias to the
location (path) specified.
Input Excel files should
include the sheet name, e.g.
file.xlsx[sheet]. Output
Excel files may optionally
include a sheet name. The file
type should be the same as
the original.

-new_window Do load the last opened

.template file, even if open
previous file at start-up is
checked in Preferences.

“verbose Output additional
information to the terminal.

This allows you to process .transform files in batch mode, e.g.:

/Applications/EasyDataTransform.app/Contents/MacOS/EasyDataTransform /Users/andy/Docur
/Applications/EasyDataTransform.app/Contents/MacOS/EasyDataTransform /Users/andy/Docul

You can also use the Mac 'open' command:

open /Applications/EasyDataTransform.app --args /Users/andy/Documents/myfile\ 1.trans
open /Applications/EasyDataTransform.app --args /Users/andy/Documents/myfile2.transfo

But note that no command line output is shown if you use 'open’.

Put single quotes (') around any arguments with spaces or a backslash (\) in front of each
space (as shown in the examples above).
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To do this on a schedule, call a script file from a scheduling program, such as launchd.

See also:
e Batch processing

2.16 .transform files

.transforms file are stored in a simple XML format. So you can edit them with a standard text
editor. However we recommend you make a copy first.

The results of transformations are not stored in the .transform file, and are recalculated
whenever you File>Open... the file.

The contents of Input and Output files are not stored in the .transform file, only their
locations. These locations are stored as 'absolute' locations, so you can move the .transform
file without changing the locations of the Input and Output files.

If you open a .transform file in a different location from that in which it was saved and it
can't find Input and Output files at the expected location it will look for them in the same
location relative to the old .transform file. This allows you to easily move .transform files to
different locations and computers if you keep the Input and Output files in the same relative
location (e.g. in the same folder as the .transform file). This even works between Windows
and Mac (and vice versa),

Example:

e mytransform.transformisin C:\Users\andy\Documents\ on Windows and uses Input
file MyData.csv in sub-folder Mybata (C:\Users\andy\Documents\Data\MyData.csv).

e mytransform.transform is moved to /Users/Bob/Documents/EDT on a Mac.

e When mytransform.transform is opened it will look for MyData.csv
in /Users/andy/Documents/Data.

¢ If it can't find that it will look for MyData.csv in sub-folder Mypata
(/Users/Bob/Documents/EDT/Data/MyData.csv).

If you paste in data From Clipboard this is stored in the .transform file. We don't

recommend you do this for large datasets as XML is not very efficient for storing large
amounts of data.
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2.17 Keyboard shortcuts

Using keyboard shortcuts can improve your productivity. If you are using Easy Data
Transform a lot we suggest you find the time to learn at least some of them. The following
keyboard shortcuts are available for the Mac version of Easy Data Transform:

Key
A

S

Backspace

Shortcut

Cmd+A

Cmd+B

Ctrl+Cmd+F

Option+I

Option+Shift+I

Cmd+N
Cmd+0
Option+O
Cmd+S

Backspace

Cmd+,

Cmd+=

Cmd++

Action

Select all in Center
pane.

Show the Batch
Process window.

Toggle setting Right
pane item to
fullscreen. Only
works if 1 item in
Right pane.

Input From File.

Input From
Clipboard.

New .transform file.
Open .transform file.
Output To File.

Save .transform file.

Delete selected
item(s) in Center
pane.

Show Preferences
window.

Zoom Center pane
so all items fit.

Zoom Center pane
in.
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Key Shortcut Action

; Cmd+- Zoom Center pane
out.

[ Option+| Move keyboard
focus to Center
pane.

] Option+] Move keyboard

focus to Right pane.

Left arrow Cmd+Left arrow

Move Center pane
selection from item
to highest[1] item

that inputs to it.

Right arrow CinehARIGIE Saror Move Center pane
selection from item
to highest[1] item
that it outputs to.

Up arrow Cmd+Up arrow

Move Center pane
selection from item
to highest[1]

sibling[3].

Down arrow Cmd+Down arrow

Move Center pane
selection from item
to lowest[2]

sibling[3].

1..9 Cmd+l...Cmd+9 Select input item 1

to 9 (based on
height in Center
pane).

Option+l...Option+9 Select Output item 1
to 9 (based on
height in Center

pane).

F1 Fl Show help.

[1] Highest=nearest the top of the Center pane.
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[2] Lowest=nearest the bottom of the Center pane.
[3] Two items are considered siblings if they have inputs from the same item(s) or they both
have no inputs.

You can also use the keyboard to add transforms in the Center pane. Just select the item(s)
you want to add the transform to and start typing the name. Only eligible transform that
contain the typed letters will be displayed (spaces are ignored).

For example, to add the Rename Cols transform an existing Input item:

e select the input items

e type ren

e press the Return key

If you want to see a list of all the transform names, press the space key before you start
typing. You can use the pel or Backspace key to undo letters typed.

You can quickly change selection in the Center pane using arrow keys with the cmd key.

Left Arrow Up Arrow

JRemove Cols

Dedupe

v/

4 ls x 209 rows

Right Arrow

4 ools x 14.7k rows

Pivot L/ Sort

2 ols x 210 rows 2 ls x 210 rows

Spread

v

104 cols x 209 rows

| Down Arrow |

If you are zoomed in you can scroll the Center pane by pressing the shift key and
dragging the canvas.
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3 How do I?
3.1 Add atransform between existing items

To add a new transform between existing items (e.g. between 2 already connected
transforms) see connections.

3.2 Add or remove a header

To add or remove a header just check or uncheck the has header checkbox for the
appropriate input item.

EA
testl.csv ¢

File: /Usersfandyb/Dropboxftestl.csv

Delimiter: Automatic

Encoding: Automatic

. & @

lgnore: Fir

=
W
n
=
]
o
=3
m
=

simplify whitespace
ignore empty rows
watch file

Alias: testl

Comment:

22 cols x 64 rows

ClB||Z Show first 10 rows H

@e first name last name suffix meal spe@

3.3 Change a connection

To change a connection see connections.
3.4 Change encoding

When Easy Data Transform inputs a text file (e.g. a CSV file) it will make a guess at the
encoding. You can explicitly set the encoding by selecting an input item and changing
Encoding from Automatic to one of the other encodings in the Right pane.
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EA
testl.csv ¢

File: Jtrunk/help/data for screen caps/testl.csv

watch file
Delimiter: Automatic H
Encoding: Automatic E

Similarly you can also set the encoding of a text file output by selecting the output item and
changing Encoding in the Right pane.

output.csv @ E :

File: fUsersfandyb/output.csy

Delimiter: Comma (,) H

Encoding: UTF-8

3.5 Dedupe a dataset

If you want to remove duplicate entries from a dataset, use the Unique transform. For
example, to remove the 2 rows that have the same email from this dataset:

| First Last Email

|1J.A. Black jablack@gmail.com

'2 Paul White p.white@hotmail.com

3 Barry Green bareen@aol.com

4 Jane Brown Jb3423@gmail.com

5. Taupe taupeB89759@gmail.com

16 John Black jablack@gmail.com

7!B. Green bgreen@aocl.com

To get this dataset:
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First Last Email

1 JA. Black jablack@gmail.com
2 Paul White p.white@hotmail.com
3 Barry Green bgreen@aol.com

4 Jane Brown Jb3423@gmail.com

51. Taupe taupe89759@gmail.com

Drag the dataset file onto the Center pane of Easy Data Transform.

mailing.xlsx
[Sheetl]

3 cols x 7 rows

Select the dataset then click the Unique transform in the Left pane.

mailing.xlsx .
v  [Sheetl] Umque

3 cols x 7 rows 3cols x5 rows

Set the Email column to Keep unique in the Right pane. Set the First and Last columns to

Keep first.
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Unique ©) b
Column Option

First Keep first H

Last Keep first %

Email Keep unique H

Keep unique for 1 of 3 columns

Concat delimiter: ,
add count column

Only one row with each email is kept. The first and last names are set to the first occurrence
in the sort order. Use Sort if you want to change the order before removing duplicates.

If you only want to remove rows with the same first name, same last name and same email,
set First, Last and Email columns to Keep unique.

Note that de-duplicating columns takes account of whitespace and case. So you might need
to do Whitespace and Case transforms before the dedupe.

See the Unigue documentation for a more detailed example.
3.6 Find the difference between dates/datetimes

You can calculate the difference between two dates or datetimes using Date objects in the
Javascript transform.

There are 4 ways to create a Javascript Date object:

Date format Description

new Date(year, month, day, hours, Specified date and time specified as
minutes, seconds, milliseconds) . .
numeric parameters (January is month 0!).

new Date (text date) Date and time specified as text.
new Date(milliseconds) Milliseconds after 1st January 1970.
new Date () Current date and time.

Notes:

¢ A text date should be in yyyy-mm-dd format.

Easy Data Transform © 2020 Oryx Digital Ltd



How do I?

¢ A Date object always includes a time. If no time is set, then the time is assumed to be
midnight GMT.
¢ One and two digit years will be interpreted from 1900.

Examples

To calculate the number of milliseconds between a date in the 'date' column and 31st Dec

2000:

return new Date( $(date) ) - new Date( "2000-12-31" );
Or:

return new Date( $(date) ) - new Date( 2000, 11, 31 );

To calculate the difference between datetimes in the 'start' and 'end' columns in hours:
return ( new Date( $(end) ) - new Date( S$S(start) ) ) / ( 60 * 60 * 1000 );
To calculate how many days ago 'date' occurred (rounded down):

return Math.floor( ( new Date() - new Date( $(date) ) ) / ( 24 * 60 * 60 * 1000 ) ):

For more information see the Javascript documentation.

3.7 Handle column name/order changes in inputs

If you have a .transform file that you want to run multiple input files through (perhaps with
a different input file each month, or as a batch process) you need to be aware of differences
in column name and column order in the input files.

To change the file being used by an input, select the input item and change the file location
in the Right pane (e,g, by clicking the "..." browse file button), rather the disconnecting the
input and connecting a new one. Otherwise column-related parameters downstream will be
reset.

Same columns in the same order, but with different names

Easy Data Transform references columns by their position (e.g. 3rd column from the left) not
their column name. So differences in column names (e.qg. first column is called "id" in input 1
and "UniquelD" in input 2) are not generally an issue. But you need to be careful if you are
using the Stack transform with Align columns by set to Header name, as this will reorder
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columns by name. If you want to always output the same column names, regardless of the
input column names, you should use a Rename Cols transform to set the names.

Same columns with the same names, but in a different order

If columns are in different orders in different input files (e.g. the "id" column in the first
column in input 1 and the second column in input 2) you need to sort the input columns
into a standard order before applying other transforms. You can so this using the Stack
transform with Align columns by set to Header name. Stack your input under a dataset
with columns in the correct order. You can use a Filter to remove any unneeded rows after
the stacking. Note stacking by header name is sensitive to case and whitespace.
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ID title first last

1 dummy

o
F N

. header-order.c...

4 cols x 1 row

.'I . t.
J INpUt.csv

-

4 cols x 2 rows

title first last ID

1Mr  John Smith 001

2 Ms Jane Smith 002

Stack _ @2

Align columns by !

Comment:

Stack rows of all inputs. Orders by the
vertical (Y) position of the input

4 cols x 3 rows i

RB 7
ID title first last
1 dummy
2 001 Mr  John Smith
3 002 Ms  Jane Smith

Stack

4 cols x 3 rows

Filter

v v

4 cols x 2 rows

Ro):

Matching any -

Filter

@ ® keep ~

mn Op Value |
1D Yi|l=v dumnD

4 ¥

Comment:

Filter rows by text, date or numeric
values in selected columns.

4 cols x 2 rows

&<

ID title first last
1001 Mr John Smith
2002 Ms Jane Smith

Same columns with different names, in a different order
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Easy Data Transform can't handle this automatically. But you can create a new .transform
and use Reorder Cols and/or Rename Cols transforms to output to a new file with the
correct column names/ordering. You can then input this to the original .transform.

3.8 Handle large datasets

Large datasets (e.g. a million data points or more) can slow down processing. If slow

processing is a problem you can:

e Add a sample transform straight after the input and set Rows to pass through only the
first 100 or so rows. Once you have completed all your transforms you can then change
the sample transform to pass through all rows.

¢ Set Right pane processing delay in the Preferences window to a longer time (say 5
seconds) to ensure that that changes aren't processed until you have finished making the
changes.

¢ Set Write mode to Disabled in output files, until you are ready to write them.

3.9 Input a fixed width format file

To input data from a fixed width file see fixed width format.

3.10 Merge datasets

Easy Data Transform has two main options for merging two datasets. Stack and Join.

Stack datasets

If you want to merge the two datasets so they are one on top of another, use the Stack
transform. For example, to Stack these two datasets:

MName ID DOB

John Black 001 01/07/1966
Paul White 002 11/03/1973

Barry Green 003 30/12/1977,

+
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i Name ID DOB

Jane Brown 004 03/11/198

! Jill Taupe 005 01/03/198

To get this dataset:

Name ID DOB
1 Q‘I_I'I Black 001 1966-07-01

2|Paul White 002 1973-03-11

3 @r}f Green 003 19??-12-_5"[}/

4 fane Brown 004 1980-11-02\

Slil\lTaupe 005 1981—(]3-[5}

Drag the two dataset files onto the Center pane of Easy Data Transform.

datasetl.xlsx|...

3 aolsx Irows

dataset2.xIsx]...
v

3 cols x 2 rows

Select the two datasets using cmd+click then click the Stack transform in the Left pane.
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datasetl.xlsx|...

3 wlsx Irows

Stack

3 olsx Srows

v

dataset2.xlsx[...

3 cols x 2 rows

The datasets are now stacked in the vertical order that the datasets are shown on the
screen. The top dataset is shown first. You can swap the the vertical positions of the
datasets to change the order in which they are stacked.

If you want to stack column n of the first dataset above column n of the second dataset, set
Align columns by to Column number.

If you want to stack columns by common header names (even if they aren't in the same
order), set Align columns by to Header name.

If you want to stack a large number of files you can do it by using batch processing to write
to an output item with Write Mode=Append.

Join datasets

If you want to merge the two datasets side-by-side using a common (‘key') column, use the
Join transform. For example, to Join these two datasets:

MName D DO

B ID  Department Level
lﬁn Black 001 1965*3?&

651 Engineering 1—\

=

2 Paul White 002 1973-03-11 2|003 Engineering 2
3 Barry Green @03 1977-12-30 I 3|004 Marketing 1
4 Jane Brown 004 1980-11-03 41002 Sales 2

1]

IS@TEUPE 005 1981{!3—31 QS Sales 3_/
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By common ID value to get this dataset:

Mame ID DOB Department Level

1 dg’h_n Black I(l.'.ll.'.il 1966-07-0 Engineering 1 )
2 |Paul White | 002 [1973-03-11 Sales 2
3|Barry Green| 003 1977-12-3( Engineering 2

4lane Brown| 004 [1980-11-04 Marketing 1

wTaupe @31981—{]3—{};1 Sales 3

Drag the two dataset files onto the Center pane of Easy Data Transform.

(%]

datasetl.xlsx|...

3 alsx Irows

dataset2.xIsx]...
v

3 cols x 2 rows

Select the two datasets using cmd+click then click the Join transform in the Left pane.
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datasetl.xlsx]...
v

Jcols x5 rows

b/ Join

5 cols x5 rows

dataset2.xlsx|...

3 cols x5 rows

Set both Top key column and Bottom key column to the common (‘key') column.

The datasets are now joined side-by-side using the common column. The top dataset is
shown on the left. You can swap the the vertical positions of the datasets to change the
order in which they are joined.

If you just want to join row N of one dataset to row N of another dataset, you can use the
Row Num transform to create a common column in each dataset.

Set Include top non-matching rows and Include bottom non-matching rows depending
on what you want to do with top and bottom dataset rows for which there are no matches.

Note that matching columns takes account of whitespace and case. So you might need to
do Whitespace and Case transforms before the join.

If you are merging numerical datasets you can also use an Interpolate transform.

Video: How to join Excel files

3.11 Move a .transform file

To move a .transform file to a different location on the same computer use File>Save As...
or Finder. You either leave the Input files at the original location or move them to the same
location relative to the .transform file (e.g. if they were in the same folder as the .transform
file before, move them to the same folder as new .transform file).

To move a .transform file to a different computer, move the Input files to the same location

relative to the .transform file (e.g. if they were in the same folder as the .transform file
before, move them to the same folder as new .transform file).
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See also .transform files.

Output nested JSON or XML

You can use the dot ('.") character in the column header to show nesting. For example:

name carb cholesterol fiber minerals.ca minerals.fe protein sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is output to JSON as:
[

"name": "Avocado Dip",
"carb": "2",
"cholesterol": "5",
"fiber": "0",
"minerals": {

"Ca": HOH,

"fe": "O"
b
"protein": "1",
"sodium": "210",
"vitamins": {

"a": "O",

e MOV

And to XML as:

<?xml version="1.0" encoding="UTF-8"?>
<root>
<record>
<name>Avocado Dip</name>
<carb>2</carb>
<cholesterol>5</cholesterol>
<fiber>0</fiber>
<protein>1</protein>
<sodium>210</sodium>
<minerals>
<ca>0</ca>
<fe>0</fe>
</minerals>
<vitamins>
<a>0</a>
<c>0</c>
</vitamins>
</record>
</root>

For more details see:

e JSON format
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e XML format

Output to Excel

To output results from a transform to an Excel .xIsx/.xls file:
e Select the transform item in the Center pane.
e Click To File at the bottom of the Left pane.

L] [ ] Easy Data Transform w1.4.0 {free trial)
DEEOQAQQHEE rHmonn
Paw Col @ Stack @[5
Hum Farmat 'r::' Align columns by;  Header name E
Pad @ Comment:
Pivet @ S1eck rows of all inputs. Orders by the vertical (Y] position
= of the Input datasets.
Remove Cols (7))
Shiw firs1 10 rews
Rename Col {?} [; [% .f 5 E
Rpoedar Coly ® tithe first rama  lastname  sufic  display nama
1 M Andrew  Adams Mr Andrew Adams
Raplace @ 1
testl.csv ik ik
P—— @ v 2 Mirs  Mikki Adams Mrs Nikiki Adams:
Sampin @ o 1 Ms  Rose  Atwel M3 Rose Atwel
Sort @ 4 Mr  Colin Ayer Mr Colin Ayer
St Cal & Stack 5 Mz Michelle Blaire Mrs Michalle Blaire
n\“ .
Foread & » I3 eols x BE rows & Mr Simon Blaire Mr Simon Blaire
@ T oM Albart Brown Mr Albart Brown
Htmp @ 8 MWrs  Cynthia  Brown Mrs Cynithia Brown
- P J test2.csv
s W 9  Miss Jane Brown Mrs Jang Brown
Subusinute @ 42 cols x LH rows
S % Mr  Dawid  Burgess Mr David Burgess
@
Summar (%
Y W Last 72 rows not shown
Todal o)

Transpose "\Z)

Teifm

[ Email us questions/fesdback

e Select *.xlIsx or *.xls from the file type drop-down list that appears.

« CSV file (*csv)

- Excel file (%xis)

CR L W TR &1 D SR 1

Note that Excel .xlsx files are typically limited to 1,048,576 rows and 16,384 columns.

See also:
e Write to multiple sheets of an Excel file
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3.14 Perform the same transforms on many files

You can perform the same set of transforms on multiple inputs in one operation using batch
processing or command line arguments.

Example 1
To convert a folder full of .csv files to .json files:

1. Select File>New to create a new transform template file

2. Drag one of the .csv files onto the Center pane. Ensure the options (encoding etc) are
correct in the Right pane.

3. Click on the To File button at the bottom of the Left pane and set the location of a .json
file to create. Ensure the options (encoding etc) are correct in the Right pane.

testl.csv output.json

v v

22 cols x 64 rows 22 cols x 64 rows

4. Select File>Batch Process.
5. In the Batch Process window change the .csv file name to *.csv and output.json to
output {testl}.json.

. ® Batch Process

Input columns can include wildcards and Excel sheet names:

E.g. '{Users/andybf/Documents/*csv' or 'fUsersfandyb/Documents/data.xlsx[*]"
Qutput columns can include: {test1}, {date}, {time}, {datetime}:

E.g. '/Users/andyb/Documents/{test1}_{datetime}.csv'

Click "Help’ for more details.

Add Remaove Clear

Input alias=test1 Qutput alias=output (Overwrite)

1 fUsers/andyb/Desktop/®.csv - |/Users/andyb/output_{test1}json

Process Stop
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6. Press the Process button. A .json file will now be created for each .csv file in the folder.

If you want to process input files from another folder then click Add to add a new row and
change the test1 input folder.

Example 2
Merge multiple .csv files into a single .csv file:

7. Select File>New to create a new transform template file

8. Drag one of the .csv files onto the Center pane. Ensure the options (encoding etc) are
correct in the Right pane.

9. Click on the To File button at the bottom of the Left pane and set the location of a
merged.csv file to create, in a different folder to the input .csv files. Ensure the options
(encoding etc) are correct.

testl.csv

J merged.csv

v

22 cols x 64 rows 22 cols x 64 rows

4. Set Write Mode to Append in the Right pane.

merged.csv @|[:2
File: /Usersfandyb/Desktop/merged/merged.csv

Delimiter: Comma (,) H

Encoding: UTF-8 pj

Values as: Modes
Byte Order Mark

Write mode H

Alias: merged

5. Select File>Batch Process.
6. In the Batch Process window change the input .csv file name to *.csv.
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@ ® Batch Process

Input columns can include wildcards and Excel sheet names:

E.g. ‘/Users/andyb/Documents/*.csv' or '/Users/andyb/Documents/data.xlsx[*]"
Output columns can include: {test1}, {date}, {time}, {datetime}:

E.g. ‘/Users/andyb/Documents/{test1}_{datetime}.csv"

Click 'Help' for more details.

Add Remove Clear

Input alias=test1 Output alias=merged (Append)

1 [Usersfandyb/Desktop/*.csv - | [Usersfandyb/Desktop/merged/merged.csv

Process Stop

7. Press the Process button. A single merged. csv file will now be created that contains a
concatenation of all the other .csv files. If merged.csv already exists, you may need to
delete it first.

If the headers are different orders in different .csv files, then you can Stack by header name
to get a consistent column order before outputting.

colum n-order....

S cols x 1 rew

Stack

merged.csv
J g

27 cols x6S rows 27 @ls x 65 rows

testl.csv

22 cobs x Bdrows
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Stack o

Align columns by( Header name ) H

Comment:

3.15 Write to multiple sheets of an Excel file

To write to multiple sheets (tabs) of the same Excel file you need to set the Write mode of
each output item to Overwrite/Sheet (to clear the sheet first) or Append (to add to
existing sheet data).

customers.xlsx[records] @ E :

File: /Users/andyb/customers.xlsx[records]

Format as: MNumber/Bool/Date/Text H
(ﬁte mode:  Overwrite H Sh@ B

v

customers.xlsx
/  [records]

customers.csv

11 cols x 91 rows

11 cols x 91 rows

customers.xlsx
2/ [summary]

12 cols x 9 rows

Y Summary

12 cols x 9 rows

customers.xlsx[summary] @ E ;

File: /Usersfandyb/customers.xlsx[summary]

Format as: MNumber/Bool/Date/Text

'ﬁ';i_te mode:  Overwrite o SheeD
Wit <
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If you set the Write mode to Overwrite/File for an item then the write will remove existing
sheets.
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Support

4.1 Contact support

If you have any questions or suggestions, please contact us at
support@easydatatransform.com .

4.2 Report abug

Please report any bugs you find to support@easydatatransform.com and we will attempt to
fix them. Please include:

e a description of the bug

e your operating system (e.g. Windows 10)

e the version of Easy Data Transform (from Help>About)

e a step-by-step description of how we can reproduce the problem
e a screen capture can often be helpful

The step-by-step description is particularly important - if we can't reproduce your problem,
then we probably won't be able to fix it.
4.3 Request an enhancement

We are always very interested to hear your suggestions on how the software can be
improved. Please email us at support@easydatatransform.com .
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